
Multi Format 
Compact Switcher

4-296-436-11 (2)

© 2011 Sony Corporation

Operating Instructions (Volume II Advanced Settings)
Before operating the unit, please read this manual thoroughly and retain it for future reference.

MCS-8M
Software Version 1.00



II-2
Chapter 1   Overview

Introduction....................................................................... II-5

System Configuration Examples ................................................II-5

Chapter 2   Video Switching

Overview ............................................................................ II-7

Setting the Transition Type .......................................... II-7

General Transition Settings ([Misc] menu)............... II-8

Bus Delegation ................................................................. II-9

Using the Bus Delegation Buttons .............................................II-9

Mixing Video Created with M/E (Mix/Effect) with 

Other Video..........................................................................II-9

Setting Wipes.................................................................. II-10

Basic Operations for Wipe .......................................................II-10

Selecting the Pattern and Direction for Wipes .........................II-11

Making Detailed Adjustments to Wipe Patterns ......................II-11

Adding the Edge to the Wipe Pattern .......................................II-12

Setting DME Wipes........................................................ II-13

Basic Operations for DME Wipe .............................................II-13

Selecting the Pattern and Direction for DME Wipes ...............II-13

Making Detailed Adjustments to DME Wipe Patterns ............II-13

Adding an Edge to a DME Wipe Pattern .................................II-14

Adjusting the Background Color of a DME Wipe ...................II-14

Details on [Effect] Menu .............................................. II-15

[Effect] Menu ...........................................................................II-15

[Wipe Modify] Menu ...............................................................II-16

[DME Wipe Modify] Menu......................................................II-18

Setting Keys.................................................................... II-19

Basic Operations for Keys........................................................II-19

Setting Key Transitions ............................................................II-20

Selecting the Pattern and Direction for Key Wipes..................II-20

Making Detailed Adjustments to Key Wipe Patterns...............II-20

Setting Key DME Wipes ..........................................................II-20

Making Detailed Adjustments to Key DME Wipe Patterns.....II-21

Selecting Key Types.................................................................II-21

Making Detailed Adjustments to the Luminance Key .............II-21

Making Detailed Adjustments to the Linear Key.....................II-21

Making Detailed Adjustments to the Chroma Key ..................II-21

Setting the Key Fill and Key Source ........................................II-21

Setting a Mask for a Key ..........................................................II-22

Adding an Edge to a Key..........................................................II-22

Adjusting the Size and Position of the Key..............................II-22

Details on [Key] Menu .................................................. II-23

[Key] Menu ..............................................................................II-23

[Resizer] Menu .........................................................................II-26

[Auto Chromakey] Menu .........................................................II-27

[Manual Chromakey] Menu .....................................................II-28

[Key Wipe Modify] Menu........................................................II-29

[Key DME Wipe Modify] Menu..............................................II-30

Chapter 3   Audio Mixing

Overview .......................................................................... II-31

Details on [Audio Channel] Menu ............................. II-31

Chapter 4   Input Image Freezing and Frame 
Memory

Overview .......................................................................... II-34

Freezing Input Images.................................................. II-34

Selecting Frame Memory for Use as Frame Memory 

Video (FM) ..................................................................... II-35

Saving Images to Frame Memory ............................. II-35

Importing and Exporting Images............................... II-36

Importing Images......................................................................II-36

Export Frame Memory .............................................................II-36

Chapter 5   Importing and Exporting Files

Importing and Exporting Configuration Data ........ II-37

Exporting Configuration Data ..................................................II-37

Importing Configuration Data ..................................................II-38

Importing and Exporting Snapshots ........................ II-38

Exporting Snapshots .................................................................II-38

Importing Snapshots .................................................................II-39

Formatting a USB Flash Drive ................................... II-39

Chapter 6   3D System

Overview .......................................................................... II-40

Making the Necessary Settings ................................. II-41

Setting the Signal Format and Video Size................................II-41

Turning 3D Mode On ...............................................................II-41

Confirming 3D Video Output...................................................II-42

Chapter 7   Controlling External Devices

Enabling/Disabling Operation from External 

Devices .......................................................................... II-43

Connecting with External Devices............................ II-43

Setting GPI Inputs ....................................................................II-43

Setting GPI Outputs/Tallies......................................................II-43

Details on [GPI/Tally] Menu ........................................ II-44

Table of Contents
(this manual)
Table of Contents



Chapter 8   Setup ([Setup] Menu)

Overview .......................................................................... II-47

System Setup (System)................................................ II-47

Details on [System] Menu ........................................................II-48

Audio Setup (Audio) ..................................................... II-49

Details on [Audio] Menu..........................................................II-49

Video Input Setup (Video (Input)).............................. II-51

Details on [Video (Input)] Menu ..............................................II-51

Assigning Video Input Signals to the Cross Point 

Buttons (Video (XPT)) ................................................ II-52

Using the Shift Button Function...............................................II-52

Details on [Video (XPT)] Menu...............................................II-52

Video Output Setup (Video (Output)) ....................... II-53

Details on [Video (Output)] Menu ...........................................II-53

Setup of Other Video Related Items 

(Video (Misc)) ............................................................... II-54

Details on [Video (Misc)] Menu ..............................................II-54

Displaying Various Information (Information) ....... II-54

Installing Application Software and Firmware 

(Install) ........................................................................... II-54

Appendix

Message List ................................................................... II-55

Errors ........................................................................................II-55

Warnings...................................................................................II-56

Information ...............................................................................II-57

Index ................................................................................ II-58

Table of Contents
(Volume I Basic Operation)

Chapitre 1   Overview

Introduction

Names and Functions of Parts

Chapitre 2   Preparations

Connecting Devices

Configuring System Settings

Configuring Video Signal Settings

Configuring Audio Signal Settings

Configuring Multi Viewer Settings

Chapitre 3   Basic Operations

Switching Video

Composing Images with Keys

Mixing Audio

Snapshots

Saving and Selecting Settings

Appendix

Effect Pattern List

Troubleshooting

Maintenance

Specifications

Index
Table of Contents II-3



II-4 About This Manual

About This Manual

This manual describes how to make adjustments and 
settings to enable you to use the advanced features of this 
unit.

For the basic operating procedures of the unit, see to “Operating 

Instructions (Volume I Basic Operation).”

How to View This Manual

About setting values

The setting values shown in bold are the factory default 
settings.

Examples:

About references

References to the Operating Instructions (Volume I Basic 
Operation) are indicated by the c mark as follows.

Example 1:
Channel faders (c Basic Operation: “Names and 
Functions of Parts”)
Example 2:
For details, see “Effect Pattern List” (c Basic 
Operation).

To find information on a specific topic
See “Index” (page II-58) at the end of this manual.
The index indicates whether the information can be found 
in “Volume I Basic Operation” or “Volume II Advanced 
Settings” and the corresponding page numbers.

Knob Parameter Meaning Setting range

V3 Format Signal format 108059, 108050, 
720p59, 720p50, 
480i59, 576i50, 
Test1, Test2, Test3

V4 Aspect Aspect ratio 16:9, 4:3
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Introduction

The unit allows you to adjust and set video effects, transitions, and audio in detail to 
perform more sophisticated switching. You can also perform 3D video switching, 
and use the frame memory function to write one screen of the input video to memory 
so that you can use it as input material.

System Configuration Examples

Example 1: When SD system

Presenter computer

Presenter 
microphone

Projector

VIDEO

DVI-D

Host microphone

DVI-I

SDI

VIDEO

SDI

PA, etc.

Multi Viewer display

Headphones

PGM monitoring display

Recording equipment 
with SDI input

Camera with SDI output

Recording equipment 
with SDI output

CD/DVD
 player

SDI

USB flash drive 
(CG material)

PGM

SDI

MIC/LINE

MIC/LINE

LINE

Camera with VIDEO output

DVI⇔HDMI 
conversion cable
II-5Introduction
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 Example 2: When 3D system

For details on configurations for 3D systems, see “Chapter 6: 3D System” (page II-40).

Presenter 
microphone

DVI-D

Host microphone

HD SDI 
(L)

HD SDI 
(PGM L, PGM R)

PA, etc.

Multi Viewer display

Headphones

Recording equipment 
with HD SDI input

Right camera

CD/DVD
 player

HD SDI (L+R)

PGM

Left camera

HD SDI 
(L)

Right camera Left camera

HD SDI (R)

PGM monitoring display

HD SDI (R)

MIC/LINE MIC/LINE

LINE

DVI⇔HDMI 
conversion cable
Introduction
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Overview

This unit allows you to apply various effects when 
switching video, and compose images using keys.
Adjustments and configurations during video switching 
are performed from the following menus.

In addition, this unit includes three video composition 
blocks, M/E (Mix/Effect), Aux1, and Aux2. By using 
Aux1 or Aux2, you can mix video (PGM) created with M/
E (Mix/Effect) with another video.

For details, see “Bus Delegation” (page II-9).

Setting the Transition 
Type

You can specify the transition type that is used when you 
perform effect transitions.
You can select any of the following transition types.
Wipe: Use a wipe to switch from the current output image 

to a new image.
NAM (Non-Additive Mix): Compare the current image 

and new image signals, and gives priority to the signal 
with the highest luminance level in the output.
For the first half of the transition, the current image is 
maintained at 100% and NAM is gradually performed 
for the new image. At the halfway point, NAM is 
performed for both images which are maintained at 
100%. In the second half, the new image is maintained 
at 100% and NAM is performed while the current 
image is gradually reduced.

DME (Digital Multi Effects): Use DME effects to 
switch the image currently being output in a manner 
that appears as if it is being wiped (DME wipe).

Settings menu: [Effect] menu > [Effect Transition] 
(page II-15)

Menu Description Reference 
page

Misc Set general transition settings 
(e.g., transition rates, color 
backgrounds).

II-8

Effect Set the transition type. II-7

Set the wipe. II-10

Set the DME wipe. II-13

Key Set the key. II-19
II-7Overview / Setting the Transition Type
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General Transition Settings ([Misc] menu)

You can set the transition rate and the color background (ColBg) with the items in the [Misc] menu.
Press the MISC button in the menu control block to display the [Misc] menu.

Menu item Description Knob Parameter Meaning Setting range
Transition 
Rate (1/2)

You can set the time (transition rate) it takes to switch 
videos when a transition is executed with the AUTO 
TRANS button, KEY TRANS button, or FTB button for 
each transition.

Tips
• The transition rate for effect transition can also be set 

under [Effect Transition] in the [Effect] menu. 
(See page II-15)

• Key transition rates can be set under [Key Transition] in 
the [Key] menu. (See page II-23)

V2 Effect Transition rate for 
effect transition

1 to 999 
frames (30)

V3 Key Transition rate for 
key transition

1 to 999 
frames (30)

V4 FTB Transition rate for 
FTB

1 to 999 
frames (30)

Transition 
Rate (2/2)

V3 Aux1 Transition rate for 
Aux1

1 to 999 
frames (30)

V4 Aux2 Transition rate for 
Aux2

1 to 999 
frames (30)

Color 
BKGD

A color signal can be generated within the unit and used 
as a single-color background. Color signals can be 
assigned to the cross point buttons (PGM button and 
PST/KEY button) and then used.

V2 Lum Luminance 0.00 to 100.00
V3 Sat Saturation 0.00 to 100.00

V4 Hue Hue 359.99 to 0.00

Port 
Enable

Enable or disable the GPI and RS-232C ports which are 
used for operation from external devices.
For details on controls for external devices, see “Chapter 7: Controlling 
External Devices” (page II-43).

V3 GPI Enables/disables 
GPI port

Enbl (enable), 
Disbl (disable)

V4 RS232C Enables/disables 
RS-232C port (for 
future expansion)

Enbl (enable), 
Disbl (disable)
General Transition Settings ([Misc] menu)
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Bus Delegation

This unit includes three video composition blocks, M/E (Mix/Effect), Aux1, and Aux2. Each block includes four or two 
buses and can execute transitions.
However, Aux1 is dedicated to Aux1 PGM bus and Aux1 PST bus mixing, Aux2 is dedicated to Aux2 PGM bus and Aux2 
PST bus mixing, and wipes, keys, and other effects cannot be added to either.

Using the Bus Delegation Buttons

Turn on (i.e., light) one of the following buttons by 
pressing it to select the control objects for the cross-point 
control block and transition control block.

To select a key source
Press a PST/KEY cross-point button while holding down 
the KEY button.

Mixing Video Created with M/E (Mix/
Effect) with Other Video

By using Aux1 or Aux2, you can mix video (PGM) created 
with M/E (Mix/Effect) with another video.
This section describes the procedure for using Aux1 as an 
example.

Preliminary settings

1 Select the Aux1 program as the program video output.

Settings menu: [Setup] menu > [Video (Output)] 
menu (page II-53)

2 Set Aux1 as the reference signal for the on-air tally.

Settings menu: [Setup] menu > [GPI/Tally] menu > 
[On Air Source] (page II-46)

Video input Video output

Preview

Program

Aux1 Preview

Aux1 Program

Aux2 Preview

Aux2 Program

Aux1 PGM Bus

Aux1 PST Bus

Aux2 PGM Bus

Aux2 PST Bus

Key Source Bus

Key Fill Bus

PST Bus

PGM Bus

Aux1

Aux2

M/E
(Mix/Effect)

Bus 
delegation 
button

Object for control

Cross-point control block Transition 
control blockPGM row PST/KEY row

BKGD PGM bus PST bus MIX, EFF

KEY PGM bus Key Fill bus, Key 
Source bus

MIX, EFF

AUX 1 Aux1 PGM 
bus

Aux1 PST bus MIX only

AUX 2 Aux2 PGM 
bus

Aux2 PST bus MIX only
II-9Bus Delegation
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Mixing operation

1 Press the AUX 1 bus delegation button.

2 Select a PGM in the PGM cross-point buttons.

3 Select the signal you want to mix in the PST/KEY 
cross-point buttons.

4 Execute the transition using the fader lever, CUT 
button, or AUTO TRANS button.

Aux1 and Aux2 settings are not stored in snapshots.

Setting Wipes

A wipe is a transition effect that switches to the next video 
by applying an effect that removes the program output 
video in a manner that appears as it is being wiped off with 
the video to be output next.
With this unit, you can make the following settings.
• Selecting the Pattern and Direction for Wipes (page 

II-11)
• Making Detailed Adjustments to Wipe Patterns (page 

II-11)
• Adding the Edge to the Wipe Pattern (page II-12)

This section describes wipe effects and basic operations 
for wipes.
Wipe settings are made in the [Effect] menu.

For details on the menu item, see “Details on [Effect] Menu” (page II-15).

The [Effect] menu does not appear in 3D mode.

Basic Operations for Wipe

Tip

Tip

Select the video for program output.

r

Select the next video for output.

r

Press the EFF transition type selection button.

r

Set the transition type to [Wipe]. 

r

Select the pattern and direction for the wipe.

r

Make detailed adjustments to the wipe pattern if necessary.

r

Execute the transition.
Setting Wipes
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Selecting the Pattern and Direction 
for Wipes

A wipe can be set to proceed in either the normal wipe 
direction (normal) or reverse wipe direction (reverse). You 
can also specify normal and reverse to be switched each 
time a transition finishes (normal/reverse).

Selecting the wipe pattern
You can select the wipe pattern using one of the following 
three methods.
• Select from the patterns assigned to the numeric buttons 

(direct selection).

For details, see “Selecting Effects with the Numeric Keypad (Direct 

Selection)” (c Basic Operation) 

• Enter the pattern number with the numeric buttons.

For details, see “Specifying effects by pattern number” (c Basic 

Operation).

• Specify the pattern number in the [Effect] menu.

Specifying the pattern number in the 
[Effect] menu
Settings menu: [Wipe Adjust] (page II-15)

For details on the wipe pattern numbers, see “Effect Pattern List” (c Basic 

Operation).

Making Detailed Adjustments to 
Wipe Patterns

You can set the position of a wipe pattern and apply 
various variations and modifiers in the [Wipe Modify] 
menu.

To display the [Wipe Modify] menu
Display the [Effect] menu, turn the V1 knob to select 
[Wipe Adjust], and press this knob.

Setting the wipe position
The wipe position can be set in the [Wipe Modify] menu 
or with the X-Y pointer in the menu control block.

Settings menu: [Wipe Modify] menu > [Positioner] 
(page II-16), [Positioner Adjust] (page II-16)

To set the position with the X-Y pointer
Press the POS button in the menu control block so that it 
lights up and then adjust the position by controlling the 
X-Y pointer.

Setting the rotation method of a wipe 
pattern
You can select from the following three rotation methods 
for wipe patterns.

Angle
Performs the wipe with the pattern inclined at a fixed 
angle.

Speed
Rotates the pattern at a fixed speed during the transition.

Magnitude
Rotates the pattern at only the set angle for one transition.

Settings menu: [Wipe Modify] menu > [Rotation] 
(page II-17), [Rotation Adjust] (page II-17)

Normal Reverse

Positioner Off Positioner On

Angle Off Angle On
II-11Setting Wipes
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Setting the aspect ratio of a wipe pattern
You can freely change the aspect ratio of a wipe pattern.

Settings menu: [Wipe Modify] menu > [Aspect] 
(page II-17)

Replicating a wipe pattern
The same pattern can be placed up to 63 times either 
horizontally or vertically, or in both directions.

Furthermore, you can select from the following four 
methods for placing the patterns.

1: All of the patterns are oriented the same way
2: Even numbered rows are moved in the horizontal 

direction
3: Even numbered columns and even numbered rows are 

reversed
4: Even numbered columns and even numbered rows are 

reversed and even numbered rows are moved in the 
horizontal direction

Settings menu: [Wipe Modify] menu > [Multi] 
(page II-17), [Multi Adjust] (page II-17)

Adding the Edge to the Wipe Pattern

You can add a border around the pattern (border), defocus 
the edge around the pattern (soft), and defocus an added 
edge of border (soft border).
The edge color can also be adjusted.

Border: You can adjust the width of the border.
Soft Edge: You can adjust the defocus condition for the 

edge.
Soft Border: You can adjust the width of the border and 

the defocus condition for the edge of the border.

Settings menu: [Wipe Edge] (page II-15), [Wipe Edge 
Color] (page II-15)

Aspect Adjustment Off Aspect Adjustment On

Multi Function Off Multi Function On

1 2 3 4

Border Soft BorderSoft Edge
Setting Wipes
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Setting DME Wipes

DME wipes are effects that use DME (digital multi effects) 
to switch the image currently being output in a manner that 
appears as if it is being wiped.
With this unit, you can make the following settings.
• Selecting the Pattern and Direction for DME Wipes 

(page II-13)
• Making Detailed Adjustments to DME Wipe Patterns 

(page II-13)
• Adding an Edge to a DME Wipe Pattern (page II-14)
• Adjusting the Background Color of a DME Wipe (page 

II-14)

This section describes DME wipe effects and basic 
operations for DME wipes.
DME wipe settings are made in the [Effect] menu.

For details on the menu item, see “Details on [Effect] Menu” (page II-15).

Basic Operations for DME Wipe

Selecting the Pattern and Direction 
for DME Wipes

For details on the pattern and direction for DME wipes, see “Selecting the 

Pattern and Direction for Wipes” (page II-11).

Settings menu: [DME Wipe Adjust] (page II-15)

Making Detailed Adjustments to 
DME Wipe Patterns

You can adjust the position of a DME wipe pattern, adjust 
the size of the sub-screen for during PinP, perform 
cropping to cut the edge of the image, and make other 
settings in the [DME Wipe Modify] menu.

To display the [DME Wipe Modify] menu
Display the [Effect] menu, turn the V1 knob to select 
[DME Wipe Adjust], and press this knob.

Setting the DME wipe position
The wipe position can be set in the [DME Wipe Modify] 
menu or with the X-Y pointer in the menu control block.

Settings menu: [DME Wipe Modify] menu > 
[Positioner] (page II-18), [Positioner Adjust] 
(page II-18)

To set the position with the X-Y pointer
Press the POS button in the menu control block so that it 
lights up, and then adjust the position by controlling the 
X-Y pointer.

Adjusting the size of the sub-screen used 
for Frame In/Out and PinP
You can adjust the size of the sub-screen that appears when 
you use the Frame In/Out and PinP DME wipe patterns.

Settings menu: [DME Wipe Modify] menu > [Size] 
(page II-18)

Cutting (cropping) the edge of an image
You can crop portions of the image that are unnecessary.

The crop function is not available in the following cases.
• When the mosaic or defocus effect pattern is selected
• When the KEY next transition selection button is 

selected

Settings menu: [DME Wipe Modify] menu > [Crop H] 
(page II-18), [Crop V] (page II-18)

Select the video for program output.

r

Select the next video for output.

r

Press the EFF transition type selection button.

r

Set the transition type to [DME]. 

r

Select the pattern and direction for the DME wipe.

r

Make detailed adjustments to the DME wipe pattern if 
necessary.

r

Execute the transition.

Note
II-13Setting DME Wipes
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The cropping process when the transition is executed is as 
follows.

Cut: Cropping is maintained during transition 
execution and then removed at the point in time 
that the transition ends.

Last 5%: Cropping is maintained as is until the 
transition progresses to 95% and then removed 
during the remaining 5%.

Linear: Cropping is linearly removed from the start of 
the transition in accordance with the progression 
of the transition.

Adding an Edge to a DME Wipe 
Pattern

With a DME wipe, you can add a border around the pattern 
(border) and defocus the edge of an added border (soft 
border).
The edge color and background color can also be adjusted.

For details on how to add an edge, see “Adding the Edge to the Wipe 

Pattern” (page II-12).

Settings menu: [DME Wipe Edge], [DME Wipe Edge 
Color] (page II-16)

Adjusting the Background Color of a 
DME Wipe

You can adjust the background color of a DME wipe.

Settings menu: [DME Wipe Bkgd Color] (page II-16)

• The background color of the DME wipe can only be used 
for Flip Tumble DME wipe patterns.

• The background color of the DME wipe is shared with 
the edge color of the wipe pattern.

0
100 (%)

y

t

(%)
100

Cut

0
100 (%)95

y

t

(%)
100

95

Last 5%

0
100 (%)

Linear

y

t

(%)
100

t: Transition execution time
y: Amount of change of transition and crop

Transition
Crop

Transition
Crop

Transition
Crop

Tips
Setting DME Wipes
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Details on [Effect] Menu

[Effect] Menu

Press the EFF button in the menu control block to display the [Effect] menu.

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Effect 
Transition

Set the transition rate and transition type 
that is used when you perform effect 
transitions.

V3 Rate Transition rate 
when executed 
with the AUTO 
TRANS button

1 to 999 frames 
(30)

II-7

V4 Type Transition type Wipe, NAM, DME

Wipe 
Adjust

Set the wipe direction and wipe pattern. 
You can also press the V1 knob to display 
the [Wipe Modify] menu (page II-16).

V1 Modify Press the knob 
to display the 
[Wipe Modify] 
menu 

– II-10

V3 Direct Wipe direction Norm (normal), 
N/R (normal/
reverse), Rev 
(reverse)

II-13

V4 PtnNum Wipe pattern 
number

1 to 24

Wipe Edge Add a border around the pattern (border), 
defocus the edge around the pattern 
(soft), and defocus an added border (soft 
border).

V2 Type Wipe edge type Off, Border, Soft 
(soft edge), 
S-Brdr (soft 
border)

II-12

V3 Width Adjusts border 
width

0.00 to 100.00

V4 Soft Defocus 
condition for 
edge

0.00 to 100.00

Wipe Edge 
Color

Adjust the color of the wipe edge. V2 Lum Luminance 0.00 to 100.00 II-12

V3 Sat Saturation 0.00 to 100.00
V4 Hue Hue 359.99 to 0.00

DME Wipe 
Adjust

Set the DME wipe direction and DME 
wipe pattern. 
You can also press the V1 knob to display 
the [DME Wipe Modify] menu (page 
II-18).

 Tip
When the KEY next transition selection 
button is selected, 1101 to 1102 (Flip 
Tumble), 1251 (PinP), 1701 (Mosaic), 
and 1702 (Defocus) cannot be selected.

V1 Modify Press the knob 
to display the 
[DME Wipe 
Modify] menu 

– II-13

V3 Direct DME wipe 
direction

Norm (normal), 
N/R (normal/
reverse), Rev 
(reverse)

V4 PtnNum DME wipe 
pattern number

1001 to 1008 
(Slide), 1021 to 
1031 (Squeeze), 
1041 to 1044 
(Door), 1201 to 
1208/1221 to 
1224 (Frame In/
Out), 1101 to 
1102 (Flip 
Tumble), 1251 
(PinP), 1701 
(Mosaic), 1702 
(Defocus)
II-15Details on [Effect] Menu
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[Wipe Modify] Menu

Display the [Wipe Modify] menu by pressing the V1 knob while [Wipe Adjust] is selected.

DME Wipe 
Edge

Add a border around the DME pattern 
(border), and defocus the edge of an 
added border (soft border).

V2 Type DME wipe edge 
type

Off, Border, 
S-Brdr (soft 
border)

II-14

V3 Width Adjusts border 
width

0.00 to 100.00 
(2.00)

V4 Soft Defocus 
condition for 
edge

0.00 to 100.00

DME Wipe 
Edge Color

Adjust the color of a DME wipe edge. V2 Lum Luminance 0.00 to 100.00 
(14.63)

II-14

V3 Sat Saturation 0.00 to 100.00 
(50.09)

V4 Hue Hue 359.99 to 0.00 
(349.83)

DME Wipe 
Bkgd Color

Adjust the background color for the DME 
wipe.

V2 Lum Background 
color luminance

0.00 to 100.00 II-14

V3 Sat Background 
color saturation

0.00 to 100.00

V4 Hue Background 
color hue

359.99 to 0.00

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Positioner Turn the positioner for adjusting the wipe 
position on/off.
If you also select [On] with the V3 knob, 
the pattern will move from the location to 
which the pattern was moved with the 
positioner to the center of the screen as a 
result of the transition.

 Tip
The patterns for which the positioner can 
be used are as follows.

17, 18, 21, 22, 23, and 24

V3 AutoCT Turns auto 
center function 
on/off

Off, On II-11

V4 Pos Turns positioner 
on/off

Off, On

Positioner 
Adjust

Adjust the wipe position.
If you want to reset the setting value to 
“0.00,” press the V4 knob.

V2 Pos H Adjusts position 
in horizontal 
direction

–200.00 to 
+200.00 (0.00) (A 
negative value 
moves the pattern 
left, and a positive 
value moves it 
right)

II-11

V3 Pos V Adjusts position 
in vertical 
direction

–200.00 to 
+200.00 (0.00) (A 
negative value 
moves the pattern 
down, and a 
positive value 
moves it up)

V4 Center Resets setting 
value to “0”

–

Details on [Effect] Menu
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Rotation Set the rotation method of a wipe pattern. V4 Rotate Rotation type Off, Angle, 
Speed, Mag 
(magnitude)

II-11

Rotation 
Adjust

Set the parameters depending on the 
rotation type selected in [Rotation].
• When [Angle] is selected: Set [Angle].
• When [Speed] is selected: Set [Speed].
• When [Mag] is selected: Set [Angle] 

and [Mag].

About setting values
Angle: –100.00 corresponds to the state 

in which the pattern is rotated once 
counterclockwise, and +100.00 to 
the state in which the pattern is 
rotated once clockwise. 0.00 
corresponds to a non-rotation state.

Mag: –200.00 rotates the pattern twice 
counterclockwise, and +200.00 
rotates the pattern twice clockwise. 
0.00 does not rotate the pattern.

Speed: –100.00 is the speed of one 
counterclockwise rotation per 
second, and +100.00 is the speed of 
one clockwise rotation per second. 
0.00 corresponds to a stationary 
state.

V2 Angle • Pattern 
inclination 
angle ([Angle])

• Pattern 
inclination 
angle when 
transition 
starts ([Mag])

–100.00 to 
+100.00 (0.00)

II-11

V3 Mag Amount of 
rotation during 
transition

–200.00 to 
+200.00 (0.00)

V4 Speed Pattern rotation 
speed

–100.00 to 
+100.00 (0.00)

Aspect Change the aspect ratio of a wipe 
pattern. Setting the aspect ratio to a 
negative value stretches the pattern 
vertically to make it longer in the vertical 
direction, and setting the aspect ratio to a 
positive value stretches the pattern 
horizontally to make it longer in the 
horizontal direction.

V3 Aspect Turns aspect 
adjustment on/
off

Off, On II-12

V4 Ratio Adjusts aspect 
ratio

–100.00 to 
+100.00 (0.00)

Multi Turn the multi function for replicating wipe 
patterns on/off.

V4 Multi Turns multi 
function on/off

Off, On II-12

Multi 
Adjust

The same pattern can be placed up to 63 
times either horizontally or vertically, or in 
both directions.

V2 H Mult Number of 
patterns to place 
in horizontal 
direction

1 to 63 II-12

V3 V Mult Number of 
patterns to place 
in vertical 
direction

1 to 63

V4 InvTyp Pattern 
placement 
method

1 to 4

Menu item Description Knob Parameter Meaning Setting range Reference 
page
II-17Details on [Effect] Menu



II-18

  C
hapter 2  V

ideo S
w

itching
[DME Wipe Modify] Menu

Display the [DME Wipe Modify] menu by pressing the V1 knob while [DME Wipe Adjust] is selected.

The crop function is not available in the following cases.
• When the 1701 (Mosaic) or 1702 (Defocus) effect pattern is selected
• When the KEY next transition selection button is selected

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Positioner Turn the positioner for adjusting the 
DME wipe position on/off.

 Tip
The patterns for which the positioner 
can be used are as follows.
1031, 1201 to 1208, 1221 to 1224, and 
1251

V4 Pos Turns positioner 
on/off

Off, On II-13

Positioner 
Adjust

Adjust the DME wipe position.
If you want to reset the setting value to 
“0.00,” press the V4 knob.

V2 Pos H Adjusts position 
in horizontal 
direction

–200.00 to +200.00 
(0.00) (A negative 
value moves the 
pattern left, and a 
positive value moves 
it right)

II-13

V3 Pos V Adjusts position 
in vertical 
direction

–200.00 to +200.00 
(0.00) (A negative 
value moves the 
pattern down, and a 
positive value moves 
it up)

V4 Center Resets setting 
value to “0”

–

Size You can adjust the size of the 
sub-screen when you use the 1201 to 
1208 (Frame In/Out), 1221 to 1224 
(Frame In/Out), and 1251 (PinP) DME 
wipe patterns.

Notes on setting values
Param: Set the enlarge/reduce ratio 

as a percentage. The 100.00 
setting is equal to the size of the 
input image.

V3 Size Turns size 
adjustment on/off

Off, On II-13

V4 Param Adjusts size 0.00 to 200.00 
(100.00)

Crop H Turn the crop function on/off, and set 
the left and right positions used when 
cropping unnecessary portions of an 
image.

V2 Crop Turns crop on/off Off, On II-13

V3 Left Position for 
cutting left 
portion of image

–100.00 to +100.00

V4 Right Position for 
cutting right 
portion of image

–100.00 to +100.00

Crop V Set the action performed when a 
transition is executed, and set the top 
and bottom positions used when 
cropping unnecessary portions of an 
image.

V2 Trans Action when 
transition 
executed

Cut, Last5%, Linear II-13

V3 Top Position for 
cutting top 
portion of image

–100.00 to +100.00

V4 Bottom Position for 
cutting bottom 
portion of image

–100.00 to +100.00

Tip
Details on [Effect] Menu
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Setting Keys

A key is a function for cutting out the background image 
and then inserting an image or text in that portion. The 
signal for cutting out the background is called a key 
source, the signal for filling the cutout portion is called a 
key fill, and the block for processing a key is called a 
keyer.

This section describes how to make detailed adjustments 
for keys.

With this unit, you can make the following settings for 
keys.
• Basic Operations for Keys (page II-19)
• Setting Key Transitions (page II-20)
• Selecting the Pattern and Direction for Key Wipes (page 

II-20)
• Making Detailed Adjustments to Key Wipe Patterns 

(page II-20)
• Setting Key DME Wipes (page II-20)
• Making Detailed Adjustments to Key DME Wipe 

Patterns (page II-21)
• Selecting Key Types (page II-21)
• Making Detailed Adjustments to the Luminance Key 

(page II-21)
• Making Detailed Adjustments to the Linear Key (page 

II-21)
• Making Detailed Adjustments to the Chroma Key (page 

II-21)
• Setting the Key Fill and Key Source (page II-21)
• Setting a Mask for a Key (page II-22)
• Adding an Edge to a Key (page II-22)
• Adjusting the Size and Position of the Key (page II-22)

For the basic operating procedures of the luminance key and chroma key, see 

“Composing Images with Keys” (c Basic Operation).

Make the key and the key transition settings in the [Key] 
menu.

For details on the [Key] menu item, see “Details on [Key] Menu” (page 

II-23).

In 3D mode, the [Key] menu is not displayed.

Basic Operations for Keys

Use the following procedure to perform basic operations 
for keys.

Depending on where you want to perform the key 
transition, perform one of the following two variations for 
basic key operations.
• Effect transition (select KEY next transition button) 

(page II-19)
• Key transition (page II-20)

Effect transition

Material selection

Transition configuration j

Key configuration j
Tip

Material selection

r

Transition configuration

r

Key configuration

r

Transition execution

Press the KEY bus delegation button.

r

Select the video for program output.

r

Select the key material (i.e., the image to be 
superimposed on the program video output).

1) Use the [Effect] menu.

Press the KEY next transition selection button to light it.

r

Press the MIX button or EFF button.

r

Set the transition type for the effect transition.1)

r

Select the pattern and direction for the wipe or DME wipe 

if necessary.1)

Select the key type.

r

Make detailed adjustments to the key if necessary.
II-19Setting Keys
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Transition execution j

Key transition

Material selection

Transition configuration j

Key configuration j

Transition execution j

Setting Key Transitions

Set the key transition rate and key transition type for when 
a key transition is performed.
You can select any of the following transition types.
Cut: Quickly insert (cut in) or remove (cut out) the key.
Mix: Gradually insert (fade in) or remove (fade out) the 

key.
Wipe: Use the wipe to cut out the background and then 

embed a key.
DME (Digital Multi Effects): Use a DME effect and 

apply the same effect as the DME wipe to the key (key 
DME wipe).

Settings menu: [Key Transition] (page II-23)

Selecting the Pattern and Direction 
for Key Wipes

You can cut out the background from a wipe pattern 
selected for a key transition and then embed a key.

Settings menu: [Key Wipe Modify] (page II-24)

For details on the wipe directions, see “Selecting the Pattern and Direction 

for Wipes” (page II-11).

For details on the wipe pattern numbers, see “Effect Pattern List” (c Basic 

Operation).

Making Detailed Adjustments to Key 
Wipe Patterns

You can set the position of a wipe pattern, and apply 
various variations and modifiers in [Key Wipe].

To display the [Key Wipe] menu
Display the [Key] menu, turn the V1 knob to select [Key 
Wipe], and press this knob.

The setting items in the [Key Wipe Modify] menu are the same as those of 

[Wipe Modify] in the [Effect] menu. For details on the setting items, see the 

corresponding sections of “Making Detailed Adjustments to Wipe Patterns” 

(page II-11).

Setting Key DME Wipes

For a key, you can make the same settings as with DME 
wipe.

Settings menu: [Key DME Wipe] (page II-24)

For details on the DME wipe directions, see “Selecting the Pattern and 

Direction for Wipes” (page II-11).

For details on the wipe pattern numbers, see “Effect Pattern List” (c Basic 

Operation).

Execute the transition using the fader lever, CUT button, 
or AUTO TRANS button.

Press the KEY bus delegation button.

r

Select the video for program output.

r

Select the key material (i.e., the image to be 
superimposed on the program video output).

1) Use the [Key] menu.

Set the transition type for the key transition.1)

r

Select the pattern and direction for the key wipe or key 

DME wipe if necessary.1)

Select the key type.

r

Make detailed adjustments to the key if necessary.

Execute the transition using the KEY TRANS button.
Setting Keys
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Making Detailed Adjustments to Key 
DME Wipe Patterns

You can adjust the position of a key DME wipe pattern and 
adjust the size of a sub-screen for during Frame In/Out and 
PinP in the [Key DME Wipe Modify] menu.

To display the [Key DME Wipe Modify] menu
Display the [Key] menu, turn the V1 knob to select [Key 
DME Wipe], and press this knob.

The setting items that can be configured in the [Key DME Wipe Modify] 

menu are the same as those of the [DME Wipe Modify] menu for a DME wipe 

(except for the crop item). See the corresponding sections of “Making 

Detailed Adjustments to DME Wipe Patterns” (page II-13).

Selecting Key Types

Select the key types to cut off the images.
You can select any of the following key types.
Lum (luminance key) / Lin (linear key): Use these 

when inserting titles or logos onto the image.
Use brightness signals such as those for black and 
white text as the key source.

Linear keys have a reduced variability in gain that 
allows more precise adjustment when compared to 
luminance keys.

Chr (chroma key): Use this when combining images of 
people with a background image, for example.
Create the key source from a particular color within 
the input image.

Settings menu: [Key Type Select] (page II-23)

Making Detailed Adjustments to the 
Luminance Key

You can make detailed adjustments for the cutout 
condition of the background, the key density, and other 
settings for composing video with luminance keys.

Settings menu: [Lum Key Adjust (1/2)] (page II-23), 
[Lum Key Adjust (2/2)] (page II-23), [Lum Key 
Mode] (page II-23)

Making Detailed Adjustments to the 
Linear Key

You can make detailed adjustments for the cutout 
condition of the background, the key density, and other 
settings for composing video with linear keys.

Settings menu: [Lin Key Adjust (1/2)] (page II-23), 
[Lin Key Adjust (2/2)] (page II-24), [Lin Key Mode] 
(page II-24)

Making Detailed Adjustments to the 
Chroma Key

When, for example, you want to fine-tune the results of 
automatic chroma key adjustment, you can specify each 
chroma key setting manually in the [Manual Chromakey] 
menu. You can also replace background colors (typically 
blue) that seep into the outline portions of the video being 
combined (such as into a subject’s hair) with colors such 
as gray to make them less conspicuous.

For details on automatic chroma key adjustment, see “Composing Images 

with Chroma Keys” (c Basic Operation).

To display the [Manual Chromakey] menu
Display the [Key] menu, turn the V1 knob to select 
[Chromakey Manual Adj], and press this knob.

For details on the [Manual Chromakey] menu, see “[Manual Chromakey] 

Menu” (page II-28).

Setting the Key Fill and Key Source

Select the signal to use for the key fill and the signal 
selection mode to use for the key source.

Settings menu: [Key Fill/Src Select] (page II-23), [Key 
Fill Mat Adjust] (page II-23)

Key source selection modes
Self: Selects the signal of the key source bus as the key 

source.
If the chroma key is selected as the key type, select 
[Self].

Auto: Automatically selects the signal of the key fill bus 
and the paired signal assigned to a cross point button 
as the key source.

Split: Allows you to select the key source bus signal 
separately from the key fill bus signal.

For details on selection, see “Selecting the key fill and key source 

separately” (c Basic Operation).

Tip
II-21Setting Keys
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The key fill and key source pairs selected when [Auto] 
is selected are as follows.

1) If you perform keying with white video as the key source, the key fill 
video will fill the entire screen.

Key fill selection modes
Bus: Signal selected with a cross point button
Matte: Signal generated with the color matte generator 

within the unit (you can adjust the color under [Key 
Fill Mat Adjust])

Setting a Mask for a Key

Key mask is a function for masking a portion of the key 
signal.

Settings menu: [Key Mask] (page II-25)

Adding an Edge to a Key

You can add a border to the edge of the key (border) and 
defocus the edge of the key (soft).

When you add a border to a key, the positions of the key 
fill and key source will move downward.

Setting modifiers for the key edge
Turn drop mode on or off and set the type of modifier.
• If you turn drop mode on, the position of the key fill and 

key source will move downward, regardless of whether 
borders are added. If you do not want to move the 
position of the key in response to whether key border is 
turned on or off, turn drop mode on.

• You can select any of the following modifiers.

Normal: The state in which a border around the key is 
not added.

Border: Allows you to add a border around the key and 
adjust the width and border density.

Settings menu: [Key Edge Type] (page II-25), [Border 
Adjust] (page II-25), [Border Matte Adjust] (page 
II-25), [Key Soft Edge] (page II-25)

Adjusting the Size and Position of 
the Key

Under the [Resizer] menu, you can apply effects, such as 
reducing, enlarging, moving, and changing the aspect 
ratio, to the created key portion in a similar manner as 
DME (resize function).

• If a resize effect is applied to the key, there will be a 
one-frame delay in the image.

• Of the DME wipe, key DME wipe, and resize functions, 
only one can be used at any one time.

To enable the resize function
Display the [Key] menu, turn the V1 knob to select 
[Resizer], and turn the V4 knob to select [On]. (See page 
II-23)

To display the [Resizer] menu
Display the [Key] menu, turn the V1 knob to select 
[Resizer], and press this knob.

For details on the [Resizer] menu, see “[Resizer] Menu” (page II-26).

Key fill Key source

Frame memory video Frame memory key

Black video White video1)

Signals other than the above Same signal as key fill

Note

World MarketV2008

World MarketV
Mask PortionThe inside of the 

mask will be used 
as the key.

 Background

Normal Border

Notes
Setting Keys
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Details on [Key] Menu

[Key] Menu

Press the KEY button in the menu control block to display the [Key] menu.

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Key 
Transition

Set the transition rate and transition type 
used when key transition is executed with 
the KEY TRANS button.

V3 Rate Transition rate 1 to 999 (30) II-20

V4 Type Transition type Cut, Mix, Wipe, 
DME

Key Type 
Select

Select the key type to cut off the images. V4 Type Key type Lum 
(Luminance 
key), Lin (Linear 
key), Chr 
(Chromakey)

II-21

Resizer Select whether to use the resize function 
that applies effects, such as reducing, 
enlarging, moving, and changing the 
aspect ratio, to the created key portion in 
a similar manner as DME.
You can also press the V1 knob to display 
the [Resizer] menu (page II-26).

V1 Select Press the knob 
to display the 
[Resizer] menu

– II-22

V4 Resize Turns resizer 
function on/off

Off, On

Key Fill/Src 
Select

Select the signal to use for the key fill and 
the signal selection mode to use for the 
key source.

V3 Source Selection mode 
of key source

Self, Auto, Split II-21

V4 Fill Signal to use as 
key fill

Bus, Matte

Key Fill Mat 
Adjust

Adjust the color of the key fill matte. V2 Lum Color matte 
luminance

0.00 to 100.00 II-21

V3 Sat Color matte 
saturation

0.00 to 100.00

V4 Hue Color matte hue 359.99 to 0.00
Lum Key 
Adjust (1/2)

Adjust the background cutout condition 
and outline sharpness of the luminance 
key.

V3 Clip Cutout condition 
for background 
(clip value)

+109.59 to –7.31 
(0.00)

–

V4 Gain Outline 
sharpness (gain 
value)

–100.00 to 
+100.00 (0.00)

Lum Key 
Adjust (2/2)

Adjust the luminance key density. V4 Dens Key density 0 to 100.00 –

Lum Key 
Mode

Turn the clean mode for the luminance 
key on/off. When the clean mode is on, 
the key source does not affect the key fill, 
which is added unchanged to the 
background.

 Tip
Clean mode is effective when you are 
using signals consisting of a paired key 
fill and key source, as with a character 
generator.

V4 Clean Turns clean 
mode on/off

Off, On –

Lin Key 
Adjust (1/2)

Adjust the background cutout condition 
and outline sharpness of the linear key.

V3 Clip Cutout condition 
for background 
(clip value)

+109.59 to –7.31 
(0.00)

–

V4 Gain Outline 
sharpness (gain 
value)

–100.00 to 
+100.00 (0.00)
II-23Details on [Key] Menu
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Lin Key 
Adjust (2/2)

Adjust the linear key density. V4 Dens Key density 0 to 100.00 –

Lin Key 
Mode

Turn the clean mode for the linear key on/
off. When the clean mode is on, the key 
source does not affect the key fill, which 
is added unchanged to the background.

 Tip
Clean mode is effective when you are 
using signals consisting of a paired key 
fill and key source, as with a character 
generator.

V4 Clean Turns clean 
mode on/off

Off, On –

Chromakey 
Auto Adj

Display the [Auto Chromakey] menu 
(page II-27) that allows you to specify a 
part of the foreground video (e.g., the 
blue background color) and use it as a 
reference for automatically creating the 
chroma key image.

V1 Auto Press the knob 
to display the 
[Auto 
Chromakey] 
menu

– Operating 
Instructions 
(Basic 
Operation)

Chromakey 
Manual Adj

Display the [Manual Chromakey] menu 
(page II-28) for making detailed 
adjustments to the chroma key.

V1 Manual Press the knob 
to display the 
[Manual 
Chromakey] 
menu

– II-21

Key Invert Invert white and black of the key source. V4 Invert Turns key source 
inversion on/off

Off, On –

Key Wipe Set the key wipe direction and key wipe 
pattern. 
You can also press the V1 knob to display 
the [Key Wipe Modify] menu (page II-29).

V1 Modify Press the knob 
to display the 
[Key Wipe 
Modify] menu 

– II-20

V3 Direct Key wipe 
direction

Norm (normal), 
N/R (normal/
reverse), Rev 
(reverse)

II-20

V4 PtnNum Key wipe pattern 
number

1 to 24

Key Wipe 
Edge

Defocus the edge of a key wipe pattern 
(soft edge).

V3 Soft Turns soft edge 
on/off

Off, On –

V4 Param Defocus 
condition for 
edge

0.00 to 100.00

Key DME 
Wipe

Set the key DME wipe direction and key 
DME wipe pattern. 
You can also press the V1 knob to display 
the [Key DME Wipe Modify] menu (page 
II-30).

V1 Modify Press the knob 
to display the 
[Key DME Wipe 
Modify] menu

– II-20

V3 Direct Key DME wipe 
direction

Norm (normal), 
N/R (normal/
reverse), Rev 
(reverse)

V4 PtnNum Key DME wipe 
pattern number

1001 to 1008 
(Slide), 1021 to 
1031 (Squeeze), 
1041 to 1044 
(Door), 1201 to 
1208, 1221 to 
1224 (Frame In/
Out)

Menu item Description Knob Parameter Meaning Setting range Reference 
page
Details on [Key] Menu



  C
hapter 2  V

ideo S
w

itching
Key Mask Set the key mask function for masking a 
portion of a key signal.

V3 Mask Turns mask 
function on/off

Off, On II-22

V4 Invert On/off of mask 
inversion

Off, On

Key Mask 
Box H

Specify the left and right positions of the 
mask box.

V3 Left Position of left 
side

–100.00 to 
+100.00 
(–50.00)

II-22

V4 Right Position of right 
side

–100.00 to 
+100.00 
(+50.00)

Key Mask 
Box V

Specify the top and bottom positions of 
the mask box.

V3 Top Position of top 
side

–100.00 to 
+100.00
 (+50.00)

II-22

V4 Bottom Position of 
bottom side

–100.00 to 
+100.00
 (–50.00)

Key Edge 
Type

Turn drop mode on or off and set modifier 
for the key edge.

V3 Drop Turns drop mode 
on/off

Off, On II-22

V4 Type Key edge type Norm (normal), 
Border

Border 
Adjust

Adjust the density and width of the 
border.

V3 Dens Border density 0.00 to 100.00 II-22

V4 Width Border width 0.00 to 4.00
Border 
Matte 
Adjust

Adjust the color of the border matte. V2 Lum Border matte 
luminance

0.00 to 100.00 II-22

V3 Sat Border matte 
saturation

0.00 to 100.00

V4 Hue Border matte 
hue

359.99 to 0.00

Key Soft 
Edge

Defocus the edge of the key (soft edge). 
Turn on the key edge and adjust the 
defocus condition of the edge.

V3 Soft Turns soft edge 
on/off

Off, On II-22

V4 Param Defocus 
condition for 
edge

0.00 to 100.00

Fine Key Turn the fine key function for fine-tuning 
the position of the key signal edge on/off.

V4 Fine Turns fine key 
function on/off

Off, On –

Fine Key 
Adjust H

When the fine key function is on, 
fine-tune the left and right positions of the 
key signal edge.

V3 Left Position of left 
side

–2.00 to +2.00 
(0.00)

–

V4 Right Position of right 
side

–2.00 to +2.00 
(0.00)

Fine Key 
Adjust V

When the fine key function is on, 
fine-tune the top and bottom positions of 
the key signal edge.

V3 Top Position of top 
side

–2.00 to +2.00 
(0.00)

–

V4 Bottom Position of 
bottom side

–2.00 to +2.00 
(0.00)

Menu item Description Knob Parameter Meaning Setting range Reference 
page
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[Resizer] Menu

Display the [Resizer] menu by pressing the V1 knob while [Resizer] (page II-23) is selected.

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Rotation 
Mode

Select whether the resizer function 
moves in 2D or 3D.

 Tip
Depending on this setting, the 
adjustment ranges for the following 
[Location], [Aspect], and [Rotation] 
settings will vary.

V3 Axis Selects rotation 
axis for 3D 
transform

X, Y –

V4 Enable Switches 
between 2D 
transform and 
3D transform

Off (2D 
transform), On 
(3D transform)

Location Reduce/enlarge and move the key.

Tips
• The setting range for the horizontal 

direction differs between HD/SD 4:3 
and SD 16:9.

• The setting range for the vertical 
direction differs between HD/SD 4:3, 
SD 16:9, and 3D.

V2 Loc X Moves key in 
horizontal 
direction

–100.00 to 
+100.00 (0.00)

–

V3 Loc Y Moves key in 
vertical direction

• When [Rotation 
Mode] is [Off], 
–100.00 to 
+100.00 (0.00)

• When [Rotation 
Mode] is [On], 
–9.00 to 9.00 
(0.00)

V4 Size Reduces/
enlarges key

• When [Rotation 
Mode] is [Off], 
0.00 to 100.00 
(1.00)

• When [Rotation 
Mode] is [On], 
0.00 to 1.00

Aspect Change the aspect ratio of a key. V2 Asp X Changes size in 
horizontal 
direction

• When [Rotation 
Mode] is [Off], 
0.00 to 100.00 
(1.00)

• When [Rotation 
Mode] is [On], 
fixed at 1.00 
(adjustment is 
disabled)

–

V3 Asp Y Changes size in 
vertical direction

• When [Rotation 
Mode] is [Off], 
0.00 to 100.00 
(1.00)

• When [Rotation 
Mode] is [On], 
fixed at 1.00 
(adjustment is 
disabled)

V4 Ratio Changes aspect 
ratio

• When [Rotation 
Mode] is [Off], 
0.00 to 2.00 
(1.00)

• When [Rotation 
Mode] is [On], 
fixed at 1.00 
(adjustment is 
disabled)
Details on [Key] Menu
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[Auto Chromakey] Menu

Display the [Auto Chromakey] menu by pressing the V1 knob while [Chromakey Auto Adj] (page II-24) is selected.

Rotation Rotate the key and adjust perspective. V2 Rot X Amount of 
X-axis rotation

• When [Rotation 
Mode] is [Off], 
fixed at 0.00 
(adjustment is 
disabled)

• When [Rotation 
Mode] is [On], 
–100.00 to 
+100.00 (0.00)

–

V3 Rot Y Amount of Y-axis 
rotation

• When [Rotation 
Mode] is [Off], 
fixed at 0.00 
(adjustment is 
disabled)

• When [Rotation 
Mode] is [On], 
–100.00 to 
+100.00 (0.00)

V4 Pers Perspective • When [Rotation 
Mode] is [Off], 
fixed at 1.00 
(adjustment is 
disabled)

• When [Rotation 
Mode] is [On], 
0.00 to 1.00

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Sample 
Mark

Display the sample mark (i.e., white box) 
for specifying the cutout color (i.e., color 
to be used as the reference of chroma 
key).

V4 Mark Turns sample 
mark display on/
off

Off, On Basic 
Operation

Sample 
Mark 
Adjust

Adjust the size and position of the sample 
mark.

 Tip
Depending on the size setting, the setting 
ranges for the horizontal and vertical 
positions will vary.

V2 Pos H Position in 
horizontal 
direction

–100.00 to 
+100.00 (0.00)

Basic 
Operation

V3 Pos V Position in 
vertical direction

–100.00 to 
+100.00 (0.00)

V4 Size Size 1.00 to 100.00 
(25.00)

Auto 
Adjust 
Execute

Execute auto chroma key.
When you press the V4 knob, auto 
chroma key is executed using the color 
specified with the sample mark as a 
reference, and the composed image is 
output.

V4 Start Press the knob 
to execute auto 
chroma key.

– Basic 
Operation
II-27Details on [Key] Menu
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[Manual Chromakey] Menu

Display the [Manual Chromakey] menu by pressing the V1 knob while [Chromakey Manual Adj] (page II-24) is selected.

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Chr Key 
Adjust 
(1/2)

Adjust the background cutout condition, 
outline sharpness, and other settings.

V2 Hue Hue of color you 
want to cut out

359.99 to 0.00 
(0.00)

–

V3 Clip Saturation of 
color you want to 
cut out

0.00 to 100.00 
(50.00)

V4 Gain Outline 
sharpness (gain 
value)

0.00 to 100.00 
(0.00)

Chr Key 
Adjust 
(2/2)

Adjust the chroma key density. V4 Dens Key density 0 to 100.00 –

Color 
Cancel

Turn on/off the color cancel function that 
removes background colors (e.g., blue 
screen) that seep into the outline areas of 
the subject of the video being combined.

V4 Cancel Turns color 
cancel function 
on/off

Off, On –

Color 
Cancel 
Adjust

Adjust the color that will be removed via 
color cancel.

V2 Lum Brightness offset 
of the color to be 
canceled

0.00 to 100.00 –

V3 Sat Saturation of 
color to be 
canceled

0.00 to 100.00

V4 Hue Hue of color to 
be canceled

359.99 to 0.00

Chr Key 
Window

Turn on/off the window function that 
allows you to adjust the detection range 
for the color you want to remove.

 Tip
When the window function is off, image 
adjustment is made within the range of 
the default values.

V4 Window Turns window 
function on/off

Off, On –

Chr Key 
Window 
Adj

Adjust the window shape. V3 Crop Position for 
cropping the top 
of the window

100.00 to 0.00 
(75.00)

–

V4 Angle Angle at which 
the window is 
opened

180.00 to 0.00 
(180.00)
Details on [Key] Menu
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[Key Wipe Modify] Menu

Display the [Key Wipe Modify] menu by pressing the V1 knob while [Key Wipe] (page II-24) is selected.

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Positioner Turn the positioner for adjusting the key 
wipe position on/off.
If you also select [On] with the V3 knob, 
the pattern will move from the location to 
which the pattern was moved with the 
positioner to the center of the screen as a 
result of the transition.

 Tip
The patterns for which the positioner can 
be used are as follows.

17, 18, 21, 22, 23, and 24

V3 AutoCT Turns auto 
center function 
on/off

Off, On –

V4 Pos Turns positioner 
on/off

Off, On

Positioner 
Adjust

Adjust the key wipe position. If you want 
to reset the setting value to “0.00,” press 
the V4 knob.

Notes on setting values
Pos H: Negative values adjust the 

position to the left, positive values to 
the right.

Pos V: Negative values adjust the 
position to the bottom, positive 
values to the top.

V2 Pos H Adjusts position 
in horizontal 
direction

–200.00 to +200.00 
(0.00)

–

V3 Pos V Adjusts position 
in vertical 
direction

–200.00 to +200.00 
(0.00)

V4 Center Resets setting 
value to “0”

–

Rotation Set the rotation method of a key wipe 
pattern.

V4 Rotate Rotation type Off, Angle, Speed, 
Mag (magnitude)

–

Rotation 
Adjust

Set the parameters depending on the 
rotation type selected in [Rotation].
• When [Angle] is selected: Set [Angle].
• When [Speed] is selected: Set [Speed].
• When [Mag] is selected: Set [Angle] 

and [Mag].

About setting values
Angle: –100.00 corresponds to the state 

in which the pattern is rotated once 
counterclockwise, and +100.00 to 
the state in which the pattern is 
rotated once clockwise. 0.00 
corresponds to a non-rotation state.

Mag: –200.00 rotates the pattern twice 
counterclockwise, and +200.00 
rotates the pattern twice clockwise. 
0.00 does not rotate the pattern.

Speed: –100.00 is the speed of one 
counterclockwise rotation per 
second, and +100.00 is the speed of 
one clockwise rotation per second. 
0.00 corresponds to a stationary 
state.

V2 Angle • Pattern 
inclination 
angle 
([Angle])

• Pattern 
inclination 
angle when 
transition 
starts ([Mag])

–100.00 to +100.00 
(0.00)

II-11

V3 Mag Amount of 
rotation during 
transition

–200.00 to +200.00 
(0.00)

V4 Speed Pattern rotation 
speed

–100.00 to +100.00 
(0.00)
II-29Details on [Key] Menu
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[Key DME Wipe Modify] Menu

Display the [Key DME Wipe Modify] menu by pressing the V1 knob while [Key DME Wipe] (page II-24) is selected.

Aspect Change the aspect ratio of a key wipe 
pattern. Setting the aspect ratio to a 
negative value stretches the pattern 
vertically to make it longer in the vertical 
direction, and setting the aspect ratio to a 
positive value stretches the pattern 
horizontally to make it longer in the 
horizontal direction.

V3 Aspect Turns aspect 
adjustment on/
off

Off, On II-12

V4 Ratio Adjusts aspect 
ratio

–100.00 to +100.00 
(0.00)

Multi Turn the multi function for replicating key 
wipe patterns on/off.

V4 Multi Turns multi 
function on/off

Off, On II-12

Multi 
Adjust

The same pattern can be placed up to 63 
times either horizontally or vertically, or in 
both directions.

V2 H Mult Number of 
patterns to 
place in 
horizontal 
direction

1 to 63 II-12

V3 V Mult Number of 
patterns to 
place in vertical 
direction

1 to 63

V4 InvTyp Pattern 
placement 
method

1 to 4

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Positioner Turn the positioner for adjusting the key 
DME wipe position on/off.

 Tip
The positioner can be used for the 
following patterns.

1031, 1201 to 1208, and 1221 to 
1224

V4 Pos Turns positioner 
on/off

Off, On –

Positioner 
Adjust

Adjust the key DME wipe position. If you 
want to reset the setting value to “0.00,” 
press the V4 knob.

Notes on setting values
Pos H: Negative values adjust the 

position to the left, positive values to 
the right.

Pos V: Negative values adjust the 
position to the bottom, positive 
values to the top.

V2 Pos H Adjusts position 
in horizontal 
direction

–200.00 to 
+200.00 (0.00)

–

V3 Pos V Adjusts position 
in vertical 
direction

–200.00 to 
+200.00 (0.00)

V4 Center Resets setting 
value to “0”

–

Size Adjusts the size of the sub-screen when 
you use the 1201 to 1208 (Frame In/Out) 
and 1221 to 1224 (Frame In/Out) key 
DME wipe patterns.

Notes on setting values
Param: Set the enlarge/reduce ratio as a 

percentage. The 100.00 setting is 
equal to the size of the input image.

V3 Size Turns size 
adjustment on/
off

Off, On –

V4 Param Adjusts size 0.00 to 200.00 
(100.00)
Details on [Key] Menu
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Overview

You can adjust the audio input in detail, set the audio levels, and specify the connectors to use for audio output for each 
audio channel.
Adjust and set the audio from the [Audio Channel] menu for each audio channel.

To display the [Audio Channel] menu
Press the ACCESS/PFL button in the same column as the channel fader assigned to the audio channel you want to adjust.

For details on assigning an input signal to each channel fader, see “Assigning Audio Input Signals to the Channel Faders” (c Basic Operation).

Details on [Audio Channel] Menu

ACCESS/PFL buttons

Menu item Description Knob Parameter Meaning Setting range Reference 
page

Input Trim Adjust the audio input signal levels. You 
can individually adjust the assigned 
channels of the audio signals input to this 
unit.

V4 Level Adjusts input 
level

–15 dB to 
+15 dB (0 dB)

–

Filter Cut high frequency and low frequency. 
Use these settings to suppress noise, 
etc.

V3 L Cut Cuts low 
frequency 
(100 Hz or less)

Off, On –

V4 H Cut Cuts high 
frequency (8 kHz 
or more)

Off, On
II-31Overview / Details on [Audio Channel] Menu
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Equalizer 
High

Use the equalizer function to adjust the 
audio quality by setting the 
high-frequency band.

V2 EQ H Turns audio 
quality 
adjustment of 
high-frequency 
band on/off

Off, On –

V3 Freq Center frequency 
of high-frequency 
band (kHz)

1.30 k to 
17.40 k (4.75 k)

V4 Level Level of 
high-frequency 
band

–15 dB to 
+15 dB (0 dB)

Equalizer 
Mid

Use the equalizer function to adjust the 
audio quality by setting the 
middle-frequency band.

V2 EQ M Turns audio 
quality 
adjustment of 
middle-frequency 
band on/off

Off, On –

V3 Freq Center frequency 
of 
middle-frequency 
band (kHz)

260.0 k to 
6.40 k (1.28 k)

V4 Level Level of 
middle-frequency 
band

–15 dB to 
+15 dB (0 dB)

Equalizer 
Low

Use the equalizer function to adjust the 
audio quality by setting the low-frequency 
band.

V2 EQ L Turns audio 
quality 
adjustment of 
low-frequency 
band on/off

Off, On –

V3 Freq Center frequency 
of low-frequency 
band (Hz)

31.0 to 420.0 
(114.1)

V4 Level Level of 
low-frequency 
band

–15 dB to 
+15 dB (0 dB)

Limiter/
Compressor

Set the limiter or compressor when 
inputting audio with large level 
differences.
• The limiter restricts the peak 

components of an audio signal with 
large level differences. It also 
compresses the sound exceeding a 
certain threshold volume, thus 
preventing excess outputs.

• The compressor gently compresses 
the level of audio at and above the 
threshold level, thus smoothing out an 
audio signal with large level 
differences.

V3 Type Selects method 
for compressing 
audio

Off, Lim 
(limiter), Comp 
(compressor)

–

V4 Thresh Level at which 
the limiter or 
compressor takes 
effect (threshold)

0 dB to –60 dB 
(–20 dB)

Pan Adjust the audio left and right balance. V4 Bal Adjusts left and 
right balance

15L to 15R (0) –

Menu item Description Knob Parameter Meaning Setting range Reference 
page
Details on [Audio Channel] Menu
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PGM Assign Output the audio from the PGM OUT 
Connector.

 Tip
The output level of the audio output from 
the PGM OUT connector can be adjusted 
with the program fader in the audio 
control block.

V4 PGM Turns output of 
the PGM OUT 
connector on/off

Off, On –

MIX OUT 
Assign

Output the audio from the MIX OUT 
Connector.

V4 MIX Turns output of 
MIX OUT 
connector on/off

Off, On –

AUX1 OUT 
Assign

Output the audio from the AUX OUT 1 
connector.

About the state of the audio that is 
output
Pre: Outputs the audio prior to level 

control with the audio channel fader.
Post: Outputs the audio in the state in 

which all of the adjustments except 
pan have been applied to the audio 
signal.

V2 AUX1 Turns output of 
AUX OUT 1 
connector on/off

Off, On –

V3 Level Adjusts audio 
level

–8 to +10 dB 
(0 dB)

V4 Type State of audio 
that is output

Pre, Post

AUX2 OUT 
Assign

Output the audio from the AUX OUT 2 
connector.

About the state of the audio that is 
output
Pre: Outputs the audio prior to level 

control with the audio channel fader.
Post: Outputs the audio in the state in 

which all of the adjustments except 
pan have been applied to the audio 
signal.

V2 AUX2 Turns output of 
AUX OUT 2 
connector on/off

Off, On –

V3 Level Adjusts audio 
level

–8 to +10 dB 
(0 dB)

V4 Type State of audio 
that is output

Pre, Post

Menu item Description Knob Parameter Meaning Setting range Reference 
page
II-33Details on [Audio Channel] Menu
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Input Image Freezing and 
Frame Memory
Overview

Input freeze is a function that allows you to freeze images 
from individual input signals.

Frame memory is a function that allows you to freeze 
images and then write it to the memory of the unit so that 
you can use it as input material.
Images that are stored in frame memory can be used as the 
video input signals (FM) of the cross point buttons (PGM 
buttons and PST/KEY buttons).

Input freeze and frame memory are not available in 3D 
mode (the [Frame Memory] menu is not displayed).

Freezing Input Images

1 Press the FM button in the menu control block to 
display the [Frame Memory] menu, and turn the V1 
knob to select [Input Freeze].

2 Turn the V3 knob to select the input signal, turn the V4 
knob to select [On], and press the V4 knob at the 
timing you want to freeze.

The input image is frozen.

If you want to freeze an image again, select [Off], 
press the V4 knob, and then select [On] again.

Tip Tip

Knob Parameter Meaning Setting range

V3 Input Selects input 
signal

SDI1, SDI2, 
SDI3, SDI4, 
DVI, H/V1, 
H/V2, H/V3

V4 Freeze Turns freeze on/
off

Off, On
Overview / Freezing Input Images
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Selecting Frame Memory 
for Use as Frame Memory 
Video (FM)

Display the [Frame Memory] menu, turn the V1 knob to 
select [Select], and turn the V4 knob to select the frame 
memory to which the image you want to use as the frame 
memory video is saved.
Frame Memory 1 to 12 are indicated as “FM1,” “FM2,” ... 
“FM12.”

Saving Images to Frame 
Memory

Select the frame memory to which to save (Frame Memory 
1 to 12), select the input signal to be used as the source, and 
then freeze the input image to write it to memory.

1 Display the [Frame Memory] menu, turn the V1 knob 
to select [Frame Memory Freeze], and then press the 
knob.

The [Frame Memory Freeze] menu appears.

2 Turn the V1 knob to select the frame memory to which 
to save the image ([Frame Memory 1] to [Frame 
Memory 12]), turn V2 and V3 knobs to select the 
source images, turn the V4 knob to select [On], and 
press the V4 knob.

The input image is saved to memory.

• If the [Store] parameter is set to [Off], the input 
video of the frame memory is output.

• If [Src K] is set to [Black], an all white signal is 
assigned to the key source image.

3 Press the FM menu selection button to exit the [Frame 
Memory Freeze] menu.

The frame memory ([Frame Memory 1] to [Frame 
Memory 12]) selected with the V1 knob in the [Frame 
Memory Freeze] menu will be automatically selected to 
the FM of the video input signal, and this will be reflected 
in the selection status of [Select] in the [Frame Memory] 
menu.

Knob Parameter Meaning Setting range

V4 FM Selects the frame 
memory to be used 
as frame memory 
video (FM)

FM1, FM2, FM3, 
FM4, FM5, FM6, 
FM7, FM8, FM9, 
FM10, FM11, 
FM12

Knob Parameter Meaning Setting range

V2 Src V Selects video 
source image

Black, SDI1, 
SDI2, SDI3, 
SDI4, DVI, H/V1, 
H/V2, H/V3, 
ColBg, PGM, 
Aux1, Aux2

V3 Src K Selects key 
source image

Black, SDI1, 
SDI2, SDI3, 
SDI4, DVI, H/V1, 
H/V2, H/V3, 
ColBg, PGM, 
Aux1, Aux2

V4 Store Saves input 
image

Off, On

Tips

Note
II-35Selecting Frame Memory for Use as Frame Memory Video (FM) / Saving Images to Frame Memory
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Importing and Exporting 
Images

You can use a USB flash drive to import images to the unit 
as frame memory, and export the frame memory saved in 
the unit.

Importing Images

File formats supported for import
• TGA
• TIFF
• BMP

• Enter up to 25 single-byte alphanumeric characters 
(including the extension) for file names. A file with a 
name of 26 characters or more will not be displayed.

• If an image is too large, the protruding portions will be 
cut. If an image is too small, the missing portions will be 
filled with black.

• Import operations are not guaranteed for TGA and TIFF 
files that include layer information.

1 Copy the images you want to import to the following 
folder on a USB flash drive, and then insert the USB 
flash drive into the USB connector of the unit.

Folder name: \Sony\MCS\FM

2 Display the [Frame Memory] menu, turn the V1 knob 
to select [Import], and press this knob.

The data in the USB flash drive is read and the files 
that can be imported are displayed.

3 Turn the V1 knob to select the first file to import, turn 
each knob to specify the frame memory and the 
number of files to import, and press the V4 knob to 
start importing.

When the V4 knob is pressed, the specified number of 
files are imported.

• If you import TGA files or TIFF files that include 
alpha channels, a frame memory that includes a key 
source will be created.

• You can import RLE-compressed TGA files.
• Compressed TIFF files cannot be imported.
• If you import BMP files, or TGA or TIFF files that 

do not include alpha channels, a frame memory with 
an all-white key source will be created.

• If a frame memory is registered to the specified 
frame memory number, it will be overwritten by the 
imported image.

Export Frame Memory

You can export the frame memory stored in the unit to a 
USB flash drive.

1 Insert the USB flash drive into the USB connector of 
the unit.

2 Display the [Frame Memory] menu and turn the V1 
knob to select [Export].

3 Turn each knob to select the frame memory to export, 
and then press the V4 knob to start exporting.

When the V4 knob is pressed, the specified number of 
frame memory is exported.

• Only BMP format files can be exported. Alpha 
channels cannot be added.

• The folder to which the files are exported and the file 
names are as shown below.
Folder name: \Sony\MCS\FM
File name: YYMMDD-HHMMSS-##.bmp

 (# is the frame memory number [01 to 12])

Notes

Knob Parameter Meaning Setting range

V2 Dest Selects the first 
frame memory 
to import

FM1, FM2, FM3, 
FM4, FM5, FM6, 
FM7, FM8, FM9, 
FM10, FM11, 
FM12

V3 Num Number of files 
to import

1 to 12

Tips

Knob Parameter Meaning Setting range

V2 Source Selects first 
frame memory 
to export

FM1, FM2, FM3, 
FM4, FM5, FM6, 
FM7, FM8, FM9, 
FM10, FM11, 
FM12

V3 Num Number of 
frame memory 
to export

1 to 12

Tips
Importing and Exporting Images



hapter5
C
Importing and Exporting 
Files
  C
hapter 5  Im

porting and E
xporting F

iles
Importing and Exporting 
Configuration Data

You can export configuration data in which various 
settings of the unit have been saved to a USB flash drive, 
and import saved configuration data to the unit.

Configuration data contains various settings of the unit. 
When you want to, for example, restore previous settings, 
you can easily make the settings by importing the 
configuration data. We recommend that you save the 
configuration data such as when you change the settings.

Exporting Configuration Data

1 Insert the USB flash drive into the USB connector of 
the unit.

2 Press the FILE button in the menu control block to 
display the [File] menu, turn the V1 knob to select 
[Export Config], and press the V4 knob to start 
exporting.

The folder to which the files are exported is as shown 
below.
Folder name: 
\Sony\MCS\CONFIG\YYMMDD-HHMMSS

The following settings are not saved under configuration 
data.

Front panel buttons
• ACCESS/PFL (1 to 6)
• DIM
• MONITOR SEL
• CH ON (1 to 6)
• Bus delegation buttons (BKGD, KEY, AUX 1, AUX 2)
• Menu selection buttons
• Numeric keypad buttons (EFF, SNAPSHOT, DIRECT/

ESC)

Menus

Miscellaneous
• Frame memory video

Tip

Tip

Note

Menu Group Parameter

Frame Memory Input Freeze Input, Freeze

Select FM

Export Source, Num

Frame Memory > Freeze All –

Frame Memory > Import All –

Misc Port Enable GPI, RS232C

File All –

File > Import Config All –

File > Import Snapshot All –

Setup > System Startup Mode All

Date All

Time All
II-37Importing and Exporting Configuration Data
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1 Insert the USB flash drive that stores the configuration 
data you want to restore into the USB connector of the 
unit.

2 Display the [File] menu, turn the V1 knob to select 
[Import Config], and press this knob.

The data in the USB flash drive is read and the 
configuration data that can be imported is displayed.

3 Turn the V1 knob to select the configuration data to 
import, and press the V4 knob to start importing.

When importing is complete, a message prompting 
you to restart the unit appears.

4 Press the V3 knob (OK), and then turn off the unit and 
turn it on again.

When you import configuration data, the startup mode 
will automatically change to [User].

For details on the startup mode, see “Startup Mode” (page II-48).

Importing and Exporting 
Snapshots

You can export the snapshots stored in the unit to a USB 
flash drive, and import the snapshots stored in the USB 
flash drive to the unit.

Snapshots cannot be imported or exported in 3D mode.

Exporting Snapshots

1 Insert the USB flash drive into the USB connector of 
the unit.

2 Display the [File] menu and turn the V1 knob to select 
[Export Snapshot], turn each knob to specify the files 
to export, and press the V4 knob to start exporting.

When the V4 knob is pressed, the specified number of 
snapshots are exported.

The folder to which the files are exported and the file 
names are as shown below.
Folder name: \Sony\MCS\SNAPSHOT
File name: YYMMDD-HHMMSS-##.SSS

(## is the snapshot number [01 to 20])

When exporting snapshots, make sure that the number 
of files in the folder does not exceed 99.

Tip

Tip

Knob Parameter Meaning Setting range

V2 Source Number of first 
snapshot to export

SS1 to SS20

V3 Num Number of 
snapshots to export

1 to 20

Tip

Note
Importing and Exporting Snapshots
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1 Insert the USB flash drive that stores the snapshots you 
want to import into the USB connector of the unit.

2 Display the [File] menu, turn the V1 knob to select 
[Import Snapshot], and then press the knob.

The data in the USB flash drive is read and the 
snapshots that can be imported are displayed.

Snapshot files are displayed in order, starting with the 
oldest.

3 Turn the V1 knob to select the snapshot to import, turn 
each knob to specify the snapshots to import, and press 
the V4 knob to start importing.

When the V4 knob is pressed, the specified number of 
snapshots are imported.

If a snapshot is already stored to the specified snapshot 
number, it will be overwritten by the imported 
snapshot.

Formatting a USB Flash 
Drive

1 Insert the USB flash drive into the USB connector of 
the unit.

2 Display the [File] menu, turn the V1 knob to select 
[USB Memory Format], and press the V4 knob to start 
formatting.

The following folders are created when formatting is 
performed.
Folder name:\Sony\MCS\CONFIG

\Sony\MCS\FM
\Sony\MCS\SNAPSHOT

Tip

Knob Parameter Meaning Setting range

V2 Dest Number of first 
snapshot to 
import

SS1 to SS20

V3 Num Number of 
snapshots to 
import

1 to 20

Tip

Tip
II-39Formatting a USB Flash Drive
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Overview

With this unit, you can create a 3D video signal by 
inputting a video for the left eye (L) and a video for the 
right eye (R) as a pair.
This chapter describes the connections and settings 
required for using the unit in a 3D system. 

Flow of connections and settings
When using the unit in a 3D system, make the following 
necessary connections and settings.

The connectors for inputting and outputting 3D video signals are fixed. When 

configuring a 3D system, see “Example 2: When 3D system” (page II-6) in 

“System Configuration Examples”.

Notes and restrictions
The following restrictions apply when configuring a 3D 
system including the unit.
• Configure the 3D system with only one MCS-8M unit. 

Two units cannot be used linked together.
• When the unit is operated in a 3D system, only an HD 

(1080i/59.94, 1080i/50, 720p/59.94, or 720p/50) signal 
format can be used. If the signal format is changed from 
HD to SD, 3D mode is canceled.

• Audio embedded in HDMI inputs cannot be used.

• The connectors that can be used for 3D video input and 
the cross point buttons to which video signals can be 
assigned are fixed as shown below.

• The connectors to which 3D video output signals can be 
assigned are fixed as shown below.

• Use a reference signal to synchronize the images from 
the 3D video input device and this unit.

• The TALLY/GPI connector will be dedicated to 
TALLY. The TALLY will be fixed at IN1 (SDI IN 1, IN 
2) and IN2 (SDI IN 3, IN 4).

Connecting Each of the Devices (page II-6)

r

Setting the Signal Format and Video Size (page II-41)

r

Turning 3D Mode On (page II-41)

r

Confirming 3D Video Output (page II-42)

Video Input 
Connector

Input Signal Cross Point 
Button

SDI IN 1 SDI 1 (L) 1

SDI IN 2 SDI 1 (R)

SDI IN 3 SDI 2 (L) 2

SDI IN 4 SDI 2 (R)

Video Output Connector Output 
signal

Remark

SDI OUT PGM PGM (L)

SDI OUT AUX 1 PGM (R)

SDI OUT AUX 2 PGM (L+R) Side by Side

SDI OUT MULTI VIEWER Multi Viewer

DVI-D OUT AUX PGM (L+R) Side by Side

DVI-D OUT MULTI 
VIEWER

Multi Viewer
Overview
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Making the Necessary 
Settings

Make the settings for operating the unit in a 3D system in 
the [Setup] menu.
Display the [Setup] menu by pressing the SETUP button in 
the menu control block.

Setting the Signal Format and Video 
Size

1 Display the [Setup] menu, select [System] menu > 
[System Format], and use the corresponding knobs to 
make each of the following settings.

The [Aspect] of the video is fixed at 16:9.

For details on the setting, see “Configuring the Signal Format and 

Aspect Ratio” (c Basic Operation).

2 Press the V3 or V4 knob.

A message prompting you to restart the unit appears.

3 Press the V3 knob (OK).

Turning 3D Mode On

1 Display the [Setup] menu, select [System] menu > [3D 
Mode], turn the V4 knob to select [On].

2 Press the V4 knob.

A message prompting you to restart the unit appears.

3 Press the V3 knob (OK), and then turn off the unit and 
turn it on again.

• In 3D mode, the BKGD bus delegation button will be lit, 
and the KEY, AUX 1, and AUX 2 buttons will be 
disabled.

• Next transition is fixed at BKGD.
• Transition types will be fixed at MIX.
• The FTB and KEY TRANS buttons in the transition 

control block will be disabled.
• The numeric keypad block will be disabled.
• In the menu control block, only the MISC, FILE, and 

SETUP buttons will be enabled.
In addition, menus will be restricted as follows.

[Misc] menu

[Setup] menu

Knob Parameter Meaning Setting Value

V3 Format Signal 
format

108059 (1080i/
59.94), 108050 
(1080i/50), 720p59 
(720p/59.94), 
720p50 (720p/50)

V4 Aspect Aspect 
ratio of 
video

16:9

Tip

Knob Parameter Meaning Setting 
Value

V4 3D Turns 3D mode on/off Off, On

Tips

Menu item Restriction

Transition 
Rate (1/2)

• Only the [Effect] transition rate is enabled.

Transition 
Rate (2/2)

• Setting is disabled.

Color 
BKGD

• Setting is disabled.

Port Enable • [GPI] is fixed at [Disbl] (disable).
• Only [RS232C] can be selected.

Menu item Restriction

Video 
(XPT)

• Movement to the sub-level setting is 
disabled (assignments for cross-point 
buttons are fixed).

Video 
(Output)

• Movement to the sub-level setting is 
disabled (assignments for video output 
are fixed).

Multi 
Viewer

• Only setting of the number of sub-screens 
is enabled.

• Assignment of video to the sub-screens is 
fixed.

GPI/Tally • Movement to the sub-level setting is 
disabled.
II-41Making the Necessary Settings
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[File] menu

• The following data will not be saved by the [Startup 
Define] operation in the [Setup] menu. These settings 
will return to default values at each startup.
– PGM bus cross-point: 1
– PST bus cross-point: 1
– Effect transition rate: 30

Confirming 3D Video Output

3D video input is assigned to the cross point buttons (PGM 
buttons and PST/KEY buttons) 1 and 2.
Press cross point buttons 1 and 2 and confirm that 3D 
video is output.

Menu item Restriction

Import 
Snapshot

• Movement to the sub-level setting is 
disabled.

Export 
Snapshot

• Exporting is disabled.
Making the Necessary Settings
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Enabling/Disabling 
Operation from External 
Devices

Enable or disable the GPI port which is used for operation 
from external devices.

1 Display the [Misc] menu, turn the V1 knob to select 
[Port Enable], and use the V3 knob to make the setting.

Connecting with External 
Devices

Set up a connection with an external device in [GPI/Tally] 
of the [Setup] menu.

In 3D mode, [GPI/Tally] is not displayed.

For details on the [GPI/Tally] menu items, see “Details on [GPI/Tally] 

Menu” (page II-44).

For details on the pin assignment of the TALLY/GPI connector, see “TALLY/

GPI connector” (c Basic Operation).

Setting GPI Inputs

Set the operation and trigger type of the GPI input 
contacts.

Settings menu: [Setup] menu > [GPI/Tally] menu > 
[GPI Input 1] to [GPI Input 4] (page II-44)

You can select from the following operations.
NotUse: No operation
CT: Cut
AT: Auto Transition
KeyCT: Key Cut
KeyAT: Key Auto Transition
Aux1CT: Aux1 Cut
Aux1AT: Aux1 Auto Transition
Aux2CT: Aux2 Cut
Aux2AT: Aux2 Auto Transition
SS1 to SS20: Snapshot Recall (1 to 20)

You can select from the following trigger types.
NotUse: The input pulse is ignored.
Rise: The trigger is applied at the rising edge of the input 

pulse.
Fall: The trigger is applied at the falling edge of the input 

pulse.
Any: The trigger is applied when the input pulse is 

inverted.

Setting GPI Outputs/Tallies

Set the GPI outputs or tallies.

Settings menu: [Setup] menu > [GPI/Tally] menu > 
[GPI Output/Tally 1] to [GPI Output/Tally 8] (page 
II-45)

You can select from the following trigger types.
NotUse: The output is fixed at a high level.
Rise: The trigger causes the output to decrease to a low 

level, and that status will continue for a certain 
duration (1 to 2 frames).

Knob Parameter Meaning Setting range

V3 GPI Enables/disables 
GPI port

Enbl (enable), 
Disbl (disable)

Tip
II-43Enabling/Disabling Operation from External Devices / Connecting with External Devices
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Fall: The trigger causes the output to decrease to a high 
level, and that status will continue for a certain 
duration (1 to 2 frames).

Any: Every time the trigger is activated, the output’s high 
and low levels change alternately.

If the GPI outputs are used as tallies, the relationship 
between Tally 1 to 8 and the input signals is as follows.

Details on [GPI/Tally] Menu

To display the [GPI/Tally] menu, display the [Setup] menu and press the V1 knob while [GPI/Tally] is selected.

Tally Input Signal

1 SDI 1

2 SDI 2

3 SDI 3

4 SDI 4

5 DVI-1

6 HDMI-1/VIDEO 1

7 HDMI-2/VIDEO 2

8 HDMI-3/VIDEO 3

Menu item Description Knob Parameter Meaning Setting range Reference 
page

GPI Input 1 Set the operation and trigger type of the 
GPI input 1 contacts.

V3 Action Contact 
operation

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT, 
SS1 to SS20

II-43

V4 Edge Trigger type NotUse, Rise, 
Fall, Any

GPI Input 2 Set the operation and trigger type of the 
GPI input 2 contacts.

V3 Action Contact 
operation

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT, 
SS1 to SS20

II-43

V4 Edge Trigger type NotUse, Rise, 
Fall, Any

GPI Input 3 Set the operation and trigger type of the 
GPI input 3 contacts.

V3 Action Contact 
operation

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, 
Aux1AT, 
Aux2CT, Aux2AT, 
SS1 to SS20

II-43

V4 Edge Trigger type NotUse, Rise, 
Fall, Any
Details on [GPI/Tally] Menu
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GPI Input 4 Set the operation and trigger type of the 
GPI input 4 contacts.

V3 Action Contact 
operation

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, 
Aux2AT, SS1 to 
SS20

II-43

V4 Edge Trigger type NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 1

Set GPI Output 1 or Tally 1. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 2

Set GPI Output 2 or Tally 2. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 3

Set GPI Output 3 or Tally 3. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 4

Set GPI Output 4 or Tally 4. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

Menu item Description Knob Parameter Meaning Setting range Reference 
page
II-45Details on [GPI/Tally] Menu
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GPI 
Output/
Tally 5

Set GPI Output 5 or Tally 5. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 6

Set GPI Output 6 or Tally 6. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 7

Set GPI Output 7 or Tally 7. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

GPI 
Output/
Tally 8

Set GPI Output 8 or Tally 8. V2 Use Selects whether 
to use as tally or 
GPI output

Tally, GPIOut 
(GPI output)

II-43

V3 Action Operation when 
used as GPI 
output

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Trigger type 
when used as 
GPI output

NotUse, Rise, 
Fall, Any

On Air 
Source

Set the reference signal for the on-air 
tally.

Notes on setting values
PGM: Tally output for input signals being 

output from PGM.
Aux1: Tally output for input signals being 

output from AUX1.
Aux2: Tally output for input signals being 

output from AUX2.

V4 Source Reference signal 
for on-air tally

PGM, Aux1, Aux2 –

Menu item Description Knob Parameter Meaning Setting range Reference 
page
Details on [GPI/Tally] Menu
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Overview

Set up the overall system in the [Setup] menu.

The [Setup] menu contains the following items.

To display the [Setup] menu
Press the SETUP button in the menu control block.

To select a menu item
Display the [Setup] menu and then turn the V1 knob to 
select a menu item.

System Setup (System)

Make system related settings in the items of the [Setup] 
menu > [System] menu.

Supported input reference signals
You can use any of the following signals as the input 
reference signal for the unit.

Menu item Description Reference 
page

Startup 
Define

Save the current setup data. Basic 
Operation

System Make system related settings. II-47

Audio Make audio related settings. II-49

Video (Input) Make video input related 
settings.

II-51

Video (XPT) Assign video input signals to 
cross point buttons.

II-52

Video 
(Output)

Make video output related 
settings.

II-53

Video (Misc) Make other video related 
settings.

II-54

Multi Viewer Set up Multi Viewer. Basic 
Operation

GPI/Tally Make GPI and tally control 
related settings.

II-43

Information Display various information 
on the unit.

II-54

Install Install application software 
and firmware.

II-54

Signal 
format

Input reference signal

HD Tri Sync SD Black 
Burst

HD system 1080i/59.94 59.94 59.94

1080i/50 50 50

720p/59.94 59.94 59.94

720p/50 50 50

SD system 480i/59.94 – 59.94

576i/50 – 50
II-47Overview / System Setup (System)
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Details on [System] Menu

Menu item Description Knob Parameter Meaning Setting range Confirmation 
(press knob)

System 
Format

Set the format and aspect ratio to be 
used by the unit.
(c Basic Operation: “Configuring the 
Signal Format and Aspect Ratio”)

 Tip
If you press the V3 or V4 knob, a 
message prompting you to restart the 
unit appears. Press the V3 knob (OK), 
and then turn off the unit and turn it on 
again.

V3 Format Signal format 108059, 
108050, 
720p59, 
720p50, 
480i59, 576i50, 
Test1, Test2, 
Test3

Necessary

V4 Aspect Aspect ratio 16:9, 4:3 Necessary

3D Mode When using a 3D system, turn 3D mode 
on.
(See “Turning 3D Mode On” (page II-41))

V4 3D Turns 3D mode 
on/off

Off, On Necessary

System 
Reference

Select the input reference signal.
BB (Black Burst): Black burst signal
Tri (Tri Sync): Tri-level sync for HD 

system
INT (Internal): Internal reference signal 

of unit (See “Supported input 
reference signals” (page II-47))

 Tip
If you press the V4 knob, a message 
prompting you to restart the unit appears. 
Press the V3 knob (OK), and then turn off 
the unit and turn it on again.

V4 Ref Input reference 
signal

BB, Tri, INT Necessary

REF OUT 
Phase

Select the output reference signal phase 
using the output video as a reference.

Notes on setting values
–1: One line in advance of output video.
0: Equal phase as output video.

 Tip
If you press the V4 knob, a message 
prompting you to restart the unit appears. 
Press the V3 knob (OK), and then turn off 
the unit and turn it on again.

V4 Phase Output reference 
signal phase

–1, 0 Necessary

Startup 
Mode

Select the setup mode (Startup mode) 
used by the unit at startup.
Fact (Factory): Starts with the factory 

default settings.
User: Starts using the setup data saved 

in [Setup] menu > [Startup Define].
(c Basic Operation: “Saving and 
Selecting Settings”)

V4 Def Startup mode Fact, User Necessary

Date Set the date for the unit’s internal clock.
(c Basic Operation: “Configuring the 
Date and Time”)

V2 Year Year 2000 to 2099 Necessary
V3 Month Month 1 to 12 Necessary
V4 Day Day 1 to 31 Necessary

Time Set the time for the unit’s internal clock.
(c Basic Operation: “Configuring the 
Date and Time”)

V3 Hour Hour 0 to 23 Necessary
V4 Min Minute 0 to 59 Necessary

LCD 
Backlight

Adjust the brightness of the backlight of 
the menu display.

V4 Bright LCD backlight 
brightness

Min (minimum), 
1, 2, 3, 4, 5, 6, 
Max 
(maximum) 

Not 
necessary
System Setup (System)
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Audio Setup (Audio)

Assign audio signal inputs to channel faders and make audio related settings in the items of the [Setup] menu > [Audio] 
menu.

SDI output embedded audio and audio signal combinations
The following table shows the possible combinations for output.

PGM and MIX are handled as a pair.
• When PGM/MIX is assigned to either L or R, the same assignment is made to the other automatically. For example, if 

L is assigned to “PGM-L,” R is assigned to “PGM-R.”
• If one of L and R is then assigned to other than PGM/MIX, the other is automatically set to “None.”

Details on [Audio] Menu

Embedded Audio Possible Combinations for Output

SDI 1 to 4 (L) PGM-L MIX-L AUX1 AUX2 AUX1 AUX2 AUX1 AUX2 None None

SDI 1 to 4 (R) PGM-R MIX-R AUX1 AUX2 AUX2 AUX1 None None AUX1 AUX2

Tip

Menu item Description Knob Parameter Meaning Setting range

Audio Input 
Assign 1

to
Audio Input 
Assign 6

Assign the audio signals input from the audio input 
connectors to channel faders 1 to 6.
(c Basic Operation: “Assigning Audio Input Signals 
to the Channel Faders”)

 Tip
In HD mode, SDI 1 to 4 and HDMI 1 to 3 are handled 
in pairs.
• When embedded audio is assigned to either L or 

R, the same assignment is made to the other 
automatically. For example, if L is assigned to 
“SDI1L,” R is assigned to “SDI1R.”

• If one of L and R is then assigned to other than the 
embedded audio of, for example, L8, the other is 
automatically set to “NotUse.”

V3 Left L audio signal NotUse, M/L1, 
M/L2, M/L3, M/L4, 
M/L5, M/L6, L7, L8, 
SDI1L, SDI2L, 
SDI3L, SDI4L, 
HDMI1L, HDMI2L, 
HDMI3L

V4 Right R audio signal NotUse, M/L1, 
M/L2, M/L3, M/L4, 
M/L5, M/L6, L7, L8, 
SDI1R, SDI2R, 
SDI3R, SDI4R, 
HDMI1R, HDMI2R, 
HDMI3R

MIC/LINE 
1 Level

to
MIC/LINE 
6 Level

Adjust the mic/line level for each channel fader. 
Adjust a level when, for example, the peak indication 
lights red or when the input signal indication does not 
light even though an audio signal is being input.
(c Basic Operation: “Assigning Audio Input Signals 
to the Channel Faders”)

V4 Level Input level –44 dB, –20 dB, 
+4 dB

SDI OUT 
PGM 
Assign

Assign the audio signals output from PGM OUT/MIX 
OUT/AUX OUT 1/AUX OUT 2 connectors to the 
embedded audio output from the PGM connector of 
SDI OUT.
For details on the possible combinations for output, see page II-49.

V3 Left Audio signal to 
assign

None, AUX1, 
AUX2, PGM-L, 
MIX-L

V4 Right Audio signal to 
assign

None, AUX1, 
AUX2, PGM-R, 
MIX-R
II-49Audio Setup (Audio)
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SDI OUT 
AUX1 
Assign

Assign the audio signals output from PGM OUT/MIX 
OUT/AUX OUT 1/AUX OUT 2 connectors to the 
embedded audio output from the AUX 1 connector of 
SDI OUT.

For details on the possible combinations for output, see page II-49.

V3 Left Audio signal to 
assign

None, AUX1, 
AUX2, PGM-L, 
MIX-L

V4 Right Audio signal to 
assign

None, AUX1, 
AUX2, PGM-R, 
MIX-R

SDI OUT 
AUX2 
Assign

Assign the audio signals output from PGM OUT/MIX 
OUT/AUX OUT 1/AUX OUT 2 connectors to the 
embedded audio output from the AUX 2 connector of 
SDI OUT.

For details on the possible combinations for output, see page II-49.

V3 Left Audio signal to 
assign

None, AUX1, 
AUX2, PGM-L, 
MIX-L

V4 Right Audio signal to 
assign

None, AUX1, 
AUX2, PGM-R, 
MIX-R

SDI OUT 
MULTI 
VIEWER 
Assign

Assign the audio signals output from PGM OUT/MIX 
OUT/AUX OUT 1/AUX OUT 2 connectors to the 
embedded audio output from the MULTI VIEWER 
connector of SDI OUT.
For details on the possible combinations for output, see page II-49.

V3 Left Audio signal to 
assign

None, AUX1, 
AUX2, PGM-L, 
MIX-L

V4 Right Audio signal to 
assign

None, AUX1, 
AUX2, PGM-R, 
MIX-R

Audio 
Output 
Delay 1

Allows you to delay the audio output from the PGM 
OUT and MIX OUT connectors on a frame basis. If 
the output video is delayed with respect to the audio, 
you can delay the audio to synchronize it with the 
video.

Note
Adjusting the delay time may result in noise being 
generated.

V3 PGM Delay time for 
audio output 
from PGM OUT 
connector

0.00 to 7.50 (1.00)

V4 MIX Delay time for 
audio output 
from MIX OUT 
connector

0.00 to 7.50 (1.00)

Audio 
Output 
Delay 2

Allows you to delay the audio output from the AUX 
OUT 1 and 2 connectors on a frame basis. If the 
output video is delayed with respect to the audio, you 
can delay the audio to synchronize it with the video.

Note
Adjusting the delay time may result in noise being 
generated.

V3 AUX1 Delay time for 
audio output 
from AUX OUT 1 
connector

0.00 to 7.50 (1.00)

V4 AUX2 Delay time for 
audio output 
from AUX OUT 2 
connector

0.00 to 7.50 (1.00)

Output 
Level

Adjust the level of audio output to each output 
destination.

 Tip
The output level of the audio output from the SDI 
OUT PGM connector can be adjusted with the 
program fader in the audio control block.

V2 MIX Output level from 
MIX OUT 
connector

–∞ to +10 dB 
(0 dB)

V3 AUX1 Output level from 
AUX OUT 1 
connector

–∞ to +10 dB 
(0 dB)

V4 AUX2 Output level from 
AUX OUT 2 
connector

–∞ to +10 dB 
(0 dB)

Oscillator You can make the settings for outputting the 
oscillator signal used for adjustment.

 Tip
If other than “Off” is selected for [Freq] when the 
output destination of the oscillator signal is set in 
[Term], the DIM button lights and the output level for 
the headphones or monitor is automatically reduced.

V2 Freq Frequency of 
oscillator signal

Off, 100 Hz, 
440 Hz, 1 kHz, 
10 kHz

V3 Level Output level of 
oscillator signal

–∞ to 0 dB 
(–20 dB)

V4 Term Terminal of 
oscillator signal

None, PGM, MIX, 
AUX1, AUX2, All 
(all output 
destinations)

Menu item Description Knob Parameter Meaning Setting range
Audio Setup (Audio)
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Video Input Setup (Video (Input))

Make video input related settings in the items of the [Setup] menu > [Video (Input)] menu.

About DVI input signals
• Set the resolution of the DVI signal to be input to one of the following in accordance with the setting of the signal format 

of the unit (page II-48). Normal images may not be obtained with other resolutions.

Although signals with resolutions other than 1920 × 1080 may be accepted when DVI input signals are set to digital, 
operation is not guaranteed.

• The image size of the DVI input signals will be adjusted to fit the screen of the unit’s signal format while maintaining 
its aspect ratio.

Details on [Video (Input)] Menu

Signal Resolution 1080i/59.94, 
1080i/50

720p/59.94, 720p/50, 
480i/59.94, 576i/50

Analog XGA (60 Hz) 1024 × 768 Yes Yes

WXGA (60 Hz) 1280 × 768 Yes Yes

SXGA (60 Hz) 1280 × 1024 Yes Yes

Digital HDTV (50 Hz) 1920 × 1080 Yes –

HDTV (60 Hz) 1920 × 1080 Yes –

Tip

Menu item Description Knob Parameter Meaning Setting range
SDI1

to
SDI4

Set the SDI signals to input via the SDI IN 1 to 4 
connectors.

V3 FS Frame 
synchronizer

Off, On

V4 Name Input source 
name

IN1 to IN8, CAM1 
to 8, VTR1 to 8, 
PC1 to 8, SDI1 to 
4, DVI, HDMI1 to 3, 
VIDEO1 to 3

DVI Set the format and input source name of the signal to 
input via the DVI-I IN connector. When you change the 
signal format, press the V3 knob to confirm the change. 
• For details on the DVI signal to be input, see “About 

DVI input signals” (page II-51).
• For details on the formats of DVI-I input video 

signals, also see “Configuring the Format of the 
Signal Input to the DVI-I Connector” (c Basic 
Operation).

V3 Format Format of 
DVI-I input 
video signal

XGA, SXGA, 
WXGA, HDTV50, 
HDTV60

V4 Name Input source 
name

IN1 to IN8, CAM1 
to 8, VTR1 to 8, 
PC1 to 8, SDI1 to 4, 
DVI, HDMI1 to 3, 
VIDEO1 to 3

HDMI1
to

HDMI3

Set the input source names of the HDMI input signals 
to be input via the HDMI IN 1 to 3 connectors.

V4 Name Input source 
name

IN1 to IN8, CAM1 
to 8, VTR1 to 8, 
PC1 to 8, SDI1 to 4, 
DVI, HDMI1 to 3, 
VIDEO1 to 3

VIDEO1
to

VIDEO3

Set the pedestal levels and input source names of the 
video input signals to be input via the VIDEO IN 1 to 3 
connectors.
When you change a pedestal level, confirm the 
modification by pressing the V3 knob.

V3 Setup Pedestal level 0IRE, 7.5IRE

V4 Name Input source 
name

IN1 to IN8, CAM1 
to 8, VTR1 to 8, 
PC1 to 8, SDI1 to 4, 
DVI, HDMI1 to 3, 
VIDEO1 to 3
II-51Video Input Setup (Video (Input))
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Assigning Video Input 
Signals to the Cross Point 
Buttons (Video (XPT))

Assign video signals to the cross point buttons (PGM 
buttons and PST/KEY buttons) in the items of the [Setup] 
menu > [Video (XPT)] menu.

For details on the setting procedure, see “Assigning Video Signals to the 

Cross-Point Buttons” (c Basic Operation).

In 3D mode, this menu is not displayed.

Using the Shift Button Function

By using the cross point button 8/SHIFT as the Shift 
button, you can assign a total of 14 materials (seven to 
cross buttons 1 to 7, and seven to cross buttons 1 to 7 + 
Shift button (cross point button 8/SHIFT)).

Settings menu: [XPT Shift Mode] (page II-52)

Numbers are assigned to the cross buttons as shown below 
in accordance with whether or not the Shift button function 
is on or off.

Shift button function: Off (non-shift mode)

Shift button function: On (shift mode)

The following table shows the factory default settings for 
assignments.

Details on [Video (XPT)] Menu

Tip

PGM/PST Cross 
Point Button

Initial Value

1 to 4 SDI IN 1 to 4 (SDI1 to SDI4)

5 DVI-I (DVI)

6 to 8 HDMI IN 1 to 3 (H/V1 to H/V3) in HD 
mode
VIDEO IN 1 to 3 (H/V1 to H/V3) in SD 
mode

9 Color background (ColBg)

10 Frame memory (FM)

11 Program output (PGM)

12 to 14 Black signal (Black)

1 2 3 4 5 6 7 8

1 2 3 4 5 6 7
8 9 10 11 12 13 14 Shift

Menu item Description Knob Parameter Meaning Setting range

XPT 
Assign 1

to
XPT 
Assign 14

Assign the video signals input from the video input 
connectors and internally generated signals to cross 
point buttons 1 to 14 (PGM buttons, PST/KEY 
buttons).

V4 Source Video signals Black, SDI1 to 4, 
DVI, H/V1 to 3, 
ColBg, FM, PGM

XPT Shift 
Mode

Select whether to use cross point button 8 as a Shift 
button.
Hold: The button operates as a shift button, and the 

cross point buttons on the shift side are enabled 
while the button is pressed.

Lock: The button operates as a shift button, and 
each press switches between the assignments 
on the shift side and non-shift side.

Off: The button operates as cross point button 8.

V4 Mode Switches 
between shift 
and non-shift

Off, Hold, Lock
Assigning Video Input Signals to the Cross Point Buttons (Video (XPT))
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Video Output Setup (Video (Output))

Set the video output signal to assign to each video output connector in the items of the [Setup] menu > [Video (Output)] 
menu.

In 3D mode, this menu is not displayed.

Details on [Video (Output)] Menu

Tip

Menu item Description Knob Parameter Meaning Setting range

SDI OUT 
PGM 
Assign

Select the signal to assign to the SDI OUT PGM 
connector.

Notes on setting values
PGM: Program
PVW: Preview
Aux1PG: Aux1 program
Aux1PV: Aux1 preview
Aux2PG: Aux2 program
Aux2PV: Aux2 preview
MV: Multi Viewer

V4 Output Output video 
signal

PGM, PVW, 
Aux1PG, Aux1PV, 
Aux2PG, Aux2PV, 
MV

SDI OUT 
AUX1 
Assign

Select the signal to assign to the SDI OUT AUX 1 
connector.

V4 Output Output video 
signal

PGM, PVW, 
Aux1PG, Aux1PV, 
Aux2PG, Aux2PV, 
MV

SDI OUT 
AUX2 
Assign

Select the signal to assign to the SDI OUT AUX 2 
connector.

V4 Output Output video 
signal

PGM, PVW, 
Aux1PG, Aux1PV, 
Aux2PG, Aux2PV, 
MV

SDI OUT 
MULTI 
VIEWER 
Assign

Select the signal to assign to the SDI OUT MULTI 
VIEWER connector.

V4 Output Output video 
signal

PGM, PVW, 
Aux1PG, Aux1PV, 
Aux2PG, Aux2PV, 
MV

DVI OUT 
AUX 
Assign

Select the signal to assign to the DVI-D OUT 
connector in HD mode, and to the VIDEO OUT AUX 
connector in SD mode.

V4 Output Output video 
signal

PGM, PVW, 
Aux1PG, Aux1PV, 
Aux2PG, Aux2PV, 
MV

DVI OUT 
MULTI 
VIEWER 
Assign

Select the signal to assign to the DVI-D OUT MULTI 
VIEWER connector.

V4 Output Output video 
signal

PGM, PVW, 
Aux1PG, Aux1PV, 
Aux2PG, Aux2PV, 
MV

VIDEO Set the pedestal level of the video output signal that 
is output via the VIDEO OUT AUX connector.
When you change a pedestal level, confirm the 
modification by pressing the V4 knob.

V4 Setup Sets pedestal 
level of VIDEO 
OUT AUX 
connector

0IRE, 7.5IRE
II-53Video Output Setup (Video (Output))
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Setup of Other Video Related Items (Video (Misc))

Make other settings related to videos in the items of the [Setup] menu > [Video (Misc)] menu.

Details on [Video (Misc)] Menu

Displaying Various 
Information (Information)

You can confirm various information on the application 
software and the firmware in the items of [Setup] menu > 
[Information].

Installing Application 
Software and Firmware 
(Install)

Install application software and firmware onto the unit 
from [Setup] menu > [Install].

It is not possible to individually select which software to 
install. All of the application software and firmware are 
installed together at one time.

1 Copy the software to be installed to the USB flash 
drive and then insert the USB flash drive into the USB 
connector of the unit.

Copy the software to be installed to the following 
folder.
Folder name: \Sony\MCS\INSTALL

2 Display the [Setup] menu > [Install] menu and then 
press the V4 knob to start the installation.

When installation is complete, a message prompting 
you to restart the unit appears. Confirm that no errors 
have occurred (i.e., “E” is not displayed).

For details on the message that appears at installation 
completion, see “Message List” (page II-55).

3 Press the V3 knob (OK), and then turn off the unit and 
turn it on again.

4 Check the version information of the application 
software and firmware under [Information] in the 
[Setup] menu.

Menu item Description Knob Parameter Meaning Setting range

Switch 
Timing

Set the timing for switching videos.

 Tip
If the signal format is set to 720p, this selection is 
ignored.

V4 Timing Switching timing Any (fastest field 
that can be 
processed), Field1 
(first field), Field2 
(second field)

Fade To 
Black

Enable or disable the FTB button of the transition 
control block.

V4 Button Enables/disables 
FTB button

Enbl (enable)/Disbl 
(disable)

Tip

Tip

Tip
Setup of Other Video Related Items (Video (Misc)) / Displaying Various Information (Information) / Installing Application Software and Firmware (Install)
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Message List

When a problem occurs on the unit during operation, the 
following types of messages appear. Before contacting 
your local Sony representative, view the following lists 
and check the possible solutions. If the problem persists, 
write down the message number that appears and contact 
your local Sony representative.

Message example:

The following message types exist.
 (Error): Indicates an inability to continue operation, 
malfunction, or other severe error.

 (Warning): Indicates that problems may occur if you 
continue operation.

 (Information): Indicates a notification.

Errors

0001

Rate

30
SS Mon

PGM

File 4203

Selec t

USB memory is not recognized.
Confirm the USB memory.

Enter

Message type

Message ID

Message

ID Message Solution

4001 An internal fan is stopped. 
Please turn off the system immediately.

The fan has stopped. Turn off the unit immediately, and contact your 
local Sony representative.

4002 The temperature in the system is rising. 
Please turn off the system immediately.

The internal temperature of the system is high. Turn off the unit 
immediately, and contact your local Sony representative.

4003 Unable to start.
Please restart.

Try restarting the unit. If it does not restart, contact your local Sony 
representative.

4004 Unable to start.
Please restart.

Try restarting the unit. If it does not restart, contact your local Sony 
representative.

4005 Unable to start.
Please restart.

Try restarting the unit. If it does not restart, contact your local Sony 
representative.

4201 Loading configuration file error. The selected configuration file may not be an MCS-8M supported file, 
or it may be damaged.

4202 Saving configuration file error.
Please retry.

The configuration file could not be saved. The USB flash drive may be 
malfunctioning or may not be supported.
II-55Message List
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Warnings

4203 USB memory is not recognized.
Confirm the USB memory.

Check whether operation has been verified with the respective USB 
flash drive model.
If operation has been verified, the USB flash drive may be damaged.4204 Formatting USB memory error.

Please retry.

4205 Reading folder/file error.
Confirm the folder/file.

4206 Making folder/file error.
Please retry.

4207 Importing error.
Please retry.

4208 Exporting error.
Please retry.

4209 More than 99 files exist in the folder. Use a computer or other device to delete unnecessary files from the 
folder so that the number of files does not exceed 99.

4210 No file in the folder.
Confirm the folder.

Files do not exist in the folder on the USB flash drive used as the 
import source. Check the folder on the USB flash drive. 
For details on folder configurations, see “Formatting a USB Flash Drive” (page II-39).

4211 No data to export.
Confirm the source.

The data specified for export does not exist on the unit. Check that the 
frame memory, snapshot, or other data specified for export has been 
created.

4212 Importing error.
Unsupported format.

Check the requirements for TGA, TIFF, and BMP files that can be 
imported.
(See page II-36)

ID Message Solution

ID Message Solution

3001 No reference signal input state detected. 
Please confirm that the reference cable is 
properly configured.

Reference signal input does not exist, although the input reference 
signal is set to [BB] or [Tri].
Set [System Reference] to [INT], or connect the appropriate reference 
signal.
(See page II-48)

3002 Reference signal unlock state detected. 
Please confirm that the reference cable is 
properly configured.

The frequency of the reference signal input does not match that of the 
system format, or it is not locked. Check the reference signal input.
(“Details on [System] Menu” (page II-48))

3003 Signal Format of HDMI IN 1 is different 
from the setting. 
Please match the signal format to the 
system format.

The input signal format of the HDMI IN 1 connector does not match 
that of the system format. Match the signal to the system format.

3004 Signal Format of HDMI IN 2 is different 
from the setting. 
Please match the signal format to the 
system format.

The input signal format of the HDMI IN 2 connector does not match 
that of the system format. Match the signal to the system format.

3005 Signal Format of HDMI IN 3 is different 
from the setting. 
Please match the signal format to the 
system format.

The input signal format of the HDMI IN 3 connector does not match 
that of the system format. Match the signal to the system format.
Message List
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Information

ID Message Solution

1101 The setting is changed. 
Perform "Startup Define", and then 
restart.

This appears when you change the system format or 3D mode, or 
when the system otherwise needs to be restarted.
Execute [Startup Define], and restart the unit.

1102 Finished. Please restart.
M: xx/B: xx/F: xx/R: xx/Font: xx
FPGA1: xx/2: xx/3: xx/4: xx

M: Main 
B: Boot 
F: Firmware 
R: Register 
Font: Font 

xx:
• "O": OK
• "E": Error
• "–": Not installed

This appears to display the results after installation of application 
software and firmware is complete.
If “E” (error) appears, try installing again. If the problem persists, 
contact your local Sony representative.

1103 Import Finished. Please restart. This appears when import of a configuration file is complete. Restart 
the unit.
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  Index
Index

Numerics
3D Mode   II-41, II-48
3D System   II-40
8/SHIFT   I-11

A
ACCESS/PFL Button   I-9, I-33, II-31
Adjustment Knobs 1 to 4   I-10

Incremental Adjustment   I-11
Aspect   II-17, II-26, II-30
Aspect Ratio   I-17
Audio   I-21, I-32

Mixing   I-32
Monitoring   I-33

Audio Channel Menu   II-31
AUX OUT Assign   II-33
Equalizer High   II-32
Equalizer Low   II-32
Equalizer Mid   II-32
Filter   II-31
Input Trim   II-31
Limiter/Compressor   II-32
MIX OUT Assign   II-33
Pan   II-32
PGM Assign   II-33

Audio Control Block   I-9
Audio Input Assign   I-21, II-49
Audio Input Block   I-13
Audio Input Signals   I-21
Audio Inputs   I-22
Audio Level Meters   I-9, I-33
Audio Menu   II-49

Audio Input Assign   II-49
Audio Output Delay   II-50
MIC/LINE Level   II-49
Oscillator   II-50
Output Level   II-50
SDI OUT AUX Assign   II-50
SDI OUT MULTI VIEWER

 Assign   II-50
SDI OUT PGM Assign   II-49

Audio Mixing   II-31
Audio Monitor   I-10
Audio Output Block   I-13
Audio Output Delay   II-50
Auto Adjust Execute   I-32, II-27
Auto Chromakey Menu   II-27

Auto Adjust Execute   II-27
Sample Mark   II-27
Sample Mark Adjust   II-27

AUTO TRANS Button   I-11, I-26, II-8
AUX 1 and 2 Buttons   I-11

AUX OUT Assign   II-33

B
BKGD Button   I-11, I-12, I-35
Border Adjust   II-25
Border Matte Adjust   II-25
Bus Delegation   II-9
Bus Delegation Button

   I-11, I-29, I-35, II-9, II-19
AUX 1 and 2 Buttons   I-11, II-9
BKGD Button   I-11, I-35, II-9
KEY Button   I-11, I-29, I-35, II-9, 

II-19, II-20

C
CH ON Button   I-9, I-32
Channel Fader   I-9, I-21, I-32, II-31
Chr   I-31
Chr Key Adjust   II-28
Chr Key Window   II-28
Chr Key Window Adj   II-28
Chroma Key   I-28, I-30

Detailed Adjustments   II-21
Chromakey Auto Adj   I-31, II-24
Chromakey Manual Adj   II-24
Color BKGD   II-8
Color Cancel   II-28
Color Cancel Adjust   II-28
Compressor   II-32
Configuration Data   II-37
Crop H   II-18
Crop V   II-18
Cropping   II-13
Cross-Point Button   I-19, I-25

Assigning Video Signals   I-19
Switching   I-25

Cross-Point Control Block   I-11
CUT Button   I-11, I-25

D
Date   I-18
Date and Time   I-18
Defocus   I-37
Digital Multi Effect   II-7, II-20
DIM Button   I-9, I-33
Dimmer   I-33
Direct Selection   I-27
DIRECT/ESC Button   I-12, I-28
DME   II-7, II-20
DME Wipe   II-13

Basic Operations   II-13
Detailed Adjustments   II-13

DME Wipe Adjust   II-15
DME Wipe Bkgd Color   II-16
DME Wipe Edge   II-16
DME Wipe Edge Color   II-16

DME Wipe Modify Menu   II-18
Crop H   II-18
Crop V   II-18
Positioner   II-18
Positioner Adjust   II-18
Size   II-18

Door   I-37
DVI   I-20, II-51
DVI Input Signals   II-51
DVI OUT AUX Assign   II-53
DVI OUT MULTI VIEWER 

Assign   II-53
DVI Video Inputs   I-20

E
EFF Button   I-10, I-11, I-12, I-28, I-29, 

I-30, II-10, II-15, II-19
Effect   I-26
Effect Menu   II-15

DME Wipe Adjust   II-15
DME Wipe Bkgd Color   II-16
DME Wipe Edge   II-16
DME Wipe Edge Color   II-16
Effect Transition   II-15
Wipe Adjust   II-15
Wipe Edge   II-15
Wipe Edge Color   II-15

Effect Pattern List   I-37
Effect Transition   II-15
Effects   I-26
ENTER Button   I-12, I-28, I-34
Equalizer   II-32
Equalizer High   II-32
Equalizer Low   II-32
Equalizer Mid   II-32
Export   II-36
Export Config   II-37
Export Snapshot   II-38
Exporting   II-36, II-37, II-38

Configuration Data   II-37
Frame Memory   II-36
Snapshot   II-38

F
F1 and F2 Buttons   I-10
Fade To Black   II-54
Fader Lever   I-12, I-26
FILE Button   I-10, II-37
File Menu   II-37, II-38, II-39

Export Config   II-37
Export Snapshot   II-38
Import Config   II-38
Import Snapshot   II-39
USB Memory Format   II-39

Fine Key   II-25
Fine Key Adjust H   II-25
Index



  Index
Fine Key Adjust V   II-25
Flip Tumble   I-37
FM Button   I-10, II-34
Formatting USB Flash Drive   II-39
Frame In/Out   I-26, I-37
Frame Memory   II-34
Frame Memory Freeze   II-35
Frame Memory Menu

   II-34, II-35, II-36
Export   II-36
Frame Memory Freeze   II-35
Import   II-36
Input Freeze   II-34
Select   II-35

Freezing   II-34
Front Panel   I-9
FTB Button   I-11, II-8, II-54

G
GPI Input   I-42, II-43, II-44
GPI Output   I-42, II-43
GPI Output/Tally   II-45
GPI/Tally Menu   II-44

GPI Input   II-44
GPI Output/Tally   II-45
On Air Source   II-46

H
HDMI   II-51

I
Import   II-36
Import Config   II-38
Import Snapshot   II-39
Importing   II-36, II-38, II-39

Configuration Data   II-38
Image   II-36
Snapshot   II-39

Information   II-54
Input Freeze   II-34
Input Reference Signals   II-47
Input Signal Indicator   I-9, I-22
Input Trim   II-31

K
Key   I-28, II-19

Basic Operations   II-19
Detailed Adjustments   II-20

KEY Button   I-10, I-11, I-12, I-29, 
I-35, II-19, II-20, II-23

Key DME Wipe   II-24
Key DME Wipe Modify Menu   II-30

Positioner   II-30
Positioner Adjust   II-30
Size   II-30

Key Edge Type   II-25
Key Fill Mat Adjust   II-23
Key Fill/Src Select   II-23
Key Invert   II-24
Key Mask   II-25
Key Mask Box H   II-25
Key Mask Box V   II-25
Key Menu   II-23

Border Adjust   II-25
Border Matte Adjust   II-25
Chromakey Auto Adj   II-24
Chromakey Manual Adj   II-24
Fine Key   II-25
Fine Key Adjust H   II-25
Fine Key Adjust V   II-25
Key DME Wipe   II-24
Key Edge Type   II-25
Key Fill Mat Adjust   II-23
Key Fill/Src Select   II-23
Key Invert   II-24
Key Mask   II-25
Key Mask Box H   II-25
Key Mask Box V   II-25
Key Soft Edge   II-25
Key Transition   II-23
Key Type Select   II-23
Key Wipe   II-24
Key Wipe Edge   II-24
Lin Key Adjust   II-23
Lin Key Mode   II-24
Lum Key Adjust   II-23
Lum Key Mode   II-23
Resizer   II-23

Key Soft Edge   II-25
KEY TRANS Button

   I-12, II-8, II-20, II-23
Key Transition   II-20
Key Type   II-21
Key Type Select   I-29, I-31, II-23
Key Wipe   II-24
Key Wipe Edge   II-24
Key Wipe Modify Menu   II-29

Aspect   II-30
Multi   II-30
Multi Adjust   II-30
Positioner   II-29
Positioner Adjust   II-29
Rotation   II-29
Rotation Adjust   II-29

L
LCD Backlight   II-48
Limiter   II-32
Limiter/Compressor   II-32
Lin Key Adjust   II-23
Lin Key Mode   II-24
Linear Key   I-28, II-21

Location   II-26
Lum   I-29
Lum Key Adjust   II-23
Lum Key Mode   II-23
Luminance Key   I-28, I-29, II-21

M
Manual Chromakey Menu   II-28

Chr Key Adjust   II-28
Chr Key Window   II-28
Chr Key Window Adj   II-28
Color Cancel   II-28
Color Cancel Adjust   II-28

Menu
Operations   I-11
Viewing   I-10

Menu Control Block   I-10
Menu Selection Button   I-10

EFF Button   I-10, II-15
FILE Button   I-10, II-37
FM Button   I-10, II-34
KEY Button   I-10, II-23
MENU1 and 2 Buttons   I-10
MISC Button   I-10, II-8
SETUP Button   I-10, I-17, I-18, 

I-19, I-20, II-47
MENU1 and 2 Buttons   I-10
Message List   II-55
MIC/LINE Level   I-22, II-49
MISC Button   I-10, II-8
Misc Menu   II-8

Color BKGD   II-8
Port Enable   II-8
Transition Rate   II-8

Mix   I-26, I-27, I-37, II-20
MIX Button

   I-11, I-27, I-29, I-30, II-19
MIX OUT Assign   II-33
MONITOR LEVEL Adjustment 

Knob   I-9, I-33
MONITOR SEL Button   I-9, I-33
Mosaic   I-37
Multi   II-17, II-30
Multi Adjust   II-17, II-30
Multi Viewer   I-23

N
NAM   I-37, II-7
Next Transition Selection Button   I-11

BKGD Button   I-11, I-12
KEY Button   I-11, I-12

Non-Additive Mix   II-7
Numeric Buttons (0 to 9)   I-12, I-27
Numeric Keypad   I-27
Numeric Keypad Block   I-12
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  Index
O
On Air Source   II-46
Oscillator   II-50
Output Level   II-50

P
Pan   II-32
Peak Indicator   I-9, I-22
PFL   I-33
PGM Assign   II-33
PGM Cross-Point Button

   I-11, I-19, I-25
Pin Configurations   I-42
PinP   I-37, II-13
Port Enable   II-8
POS Button   I-10, II-11, II-13
Positioner   II-16, II-18, II-29
Positioner Adjust

   II-16, II-18, II-29, II-30
Pre-Fade Listen   I-33
Preview Video   I-23
Program Fader   I-9, I-32
Program Video   I-23
PST/KEY Cross-Point Button

   I-11, I-19, I-25

R
REF OUT Phase   II-48
Reference Signal Input/Output 

Block   I-14
Resizer   II-23
Resizer Menu   II-26

Aspect   II-26
Location   II-26
Rotation   II-27
Rotation Mode   II-26

Rotation   II-17, II-29
Rotation Adjust   II-17, II-29
Rotation Mode   II-26

S
Sample Mark   I-31, II-27
Sample Mark Adjust   I-31, II-27
Saving Settings   I-35
SDI   II-51
SDI OUT AUX Assign   II-50, II-53
SDI OUT MULTI VIEWER 

Assign   II-50, II-53
SDI OUT PGM Assign   II-49, II-53
Select   II-35
Setup   II-47
SETUP Button

   I-10, I-17, I-18, I-19, I-20, II-47
Setup Menu   II-44, II-47, II-49, II-51, 

II-52, II-53, II-54

Audio   II-49
GPI/Tally   II-44
Information   II-54
Install   II-54
Multi Viewer   I-23
Startup Define   I-35
System   II-47
Video (Input)   II-51
Video (Misc)   II-54
Video (Output)   II-53
Video (XPT)   II-52

SHIFT   II-52
Signal Assign   I-23
Signal Format   I-17
Size   II-18
Slide   I-37
Snapshot   I-34, II-38

Recalling   I-34
Saving   I-34
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Interface are registered trademarks or trademarks of 
HDMI Licensing LLC.
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